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1. Introduction

SeaStar is supporting software for the DST magnetic Data Storage Tag. SeaStar
can run under versions newer than Win 2000. This manual takes you step-by-step
through the program installation, hardware connections and use of the SeaStar
Program. New updates of SeaStar will be available for free download at:
http://www.star-oddi.com/Online-Support/Software-updates/.

Please note that the downloaded file has to be installed into the existing SeaStar
folder. The update alone is not a complete program and therefore will not work like
that. Follow the instructions on the update website for correct installation.

This manual guides the users of DST magnetic through the operation of the recorder.
Setting the operating parameters as well as data retrieval requires access to a PC
computer with a standard RS-232C serial interface or USB.

DST magnetic is a compact microprocessor-controlled compass, tilt, temperature
and depth recorder with electronics housed in a waterproof ceramic housing.

The sensors are located as shown on the diagram below.

Tilt

Pressure (depth) sensor

\ Temperature sensor

Compass
Figure 1.1 DST Sensors

It is extremely important that the area is kept free where the pressure sensor is, to
allow free flow of water/liquid to the temperature and pressure sensors. Please note
that the pressure sensor membrane is fragile, and objects should not be pressed
against it, as it might cause damage.

©2014 Star-Oddi. All Rights Reserved Page 5


http://www.star-oddi.com/Online-Support/Software-updates/

User Manual SeaStar graphic Supporting Software

1.1 Install

To download SeaStar visit www.star-oddi.com/downloads. To install the program,
follow the automatic InstallShield Wizard.

Follow the instructions on the screen. You will be prompted for a directory name for
your SeaStar program.

Type in your product key. Please keep the product key in a safe location as you may
need it for future use. The product key works for multiple computers on the same
network.

1.2 Uninstall
To uninstall the program, do the following:

1. Click on the Start button in Windows.

2. Go to Settings and Control Panel.

3. Choose Add/Remove Programs.

4. Choose SeaStar and click on Change/Remove, and ‘Yes to all'.

©2014 Star-Oddi. All Rights Reserved Page 6
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2. Preparation

This chapter describes preparations that should be carried out before connecting to
the recorder.

Start SeaStar and the following window appears:

) SeaStar 5.16 - DST magnetic - C:\SeaStar\DST magnetic\ [E=gE=E )
File Edit Recorder Settings View Wizards Window Help

| | [PowOn [Coml | A

Figure 2.1 SeaStar Main Window

If you are starting the software for the first time, you will be asked if you want the
Connection Wizard to open automatically each time you start SeaStar. If you change
your mind you can always change the settings under Settings-Options-Startup.

2.1 Select Recorder Type

SeaStar is compatible with other Star-Oddi instruments. A recorder type must be
selected before connecting to the recorder. The default setting in the software is set
to Starmon mini as a recorder type. Change the recorder type to DST magnetic by
doing the following:

1. Choose the File menu and the New Recorder Type command.
2. Select DST magnetic as a recorder type.

©2014 Star-Oddi. All Rights Reserved Page 7
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SeaStar - Select Recorder Type &I

Available Recorders;

oK
EEEE

Cancel

Figure 2.2 Select DST Magnetic as Recorder Type

Before connecting to the recorder, it is important that the clock on the PC computer is
correct. This is important since the recorder automatically downloads the PC clock
settings.

2.2 Configuration of the Communication Port

It is necessary to define which USB or serial port on your PC computer you will use
for connecting the Communication Box.

Using the USB Serial Converter
If you are using the USB serial converter you will need to download and install the
driver from www.star-oddi.com/downloads.

The easiest way is to use the Connection Wizard. When opening the software the
following window appears:

i =

Connection Wizard

If using a communication box:
Connect the box to the computer and insert the DST
If using a StarCom cable:
Connect cable between the recorder and computer

COM1

Figure 2.3 Connection Wizard
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Connect the USB cable and the selected port will appear in the wizard pop-up
window (see figure 2.3).

The serial port can also be defined manually in the following way:

1. Choose the Communication command in the Settings menu.
The Communication definition dialog box appears.

2. Select a serial port for communications.

3. Choose the OK button.

) Communication Definition

= | B [

Select communication port

+ COM1

" COM3

Port enable / Power -
« 0ON
" OFF

oK I

" COM4

Figure 2.4 Communication Port Configuration

After you plug in the USB cable you will see a new communication port in your device
manager, called Prolific USB-to-Serial Comm Port. Make sure that the port is
enabled and select the appropriate port in SeaStar.

£ Device Manager

File  Action Yiew Help

B EE P2 ARg

+
4
+
+

T
T

4
-

-}
—

&

Computer

Disk drives

Display adapters
DDYCD-ROM drives

+|-{&g Human Interface Devices

+ IDE ATA/ATAPT cantrollers
+-zs Keyboards

+-1") Mice and ather pointing devices
+- 5 Monitars

+|-EE Network adapters

=1 Ports (COM&LPT)

néyi Comrmunications Port (COM1L)
5 ECP Prinker Port (LPT1)

F‘.* Intel{R) Active Management Technology - SOL (COM3)

Pralific USB-ta-Serial Corm Port (COME)

+ ﬂ Processors
+-@ Sound, video and game controllers

Swshem devices
Universal Serial Bus controllers

Figure 2.5 USB Communication Port in Device Manager

©2014 Star-Oddi. All Rights Reserved
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Using the Serial Port

To check which communication ports are available on your computer, open your
Device Manager. On Windows XP you can do it following way: Control panel >
system > hardware > device manager.

Under Ports you can view all available ports. Make sure that the port you are intending
to use is enabled: right-click on the appropriate port and select properties. Under
Device usage it should state use this device (enable).

Communications Port (COM1) Properties

General |F'0rtSettings Diriver || Detals | Resources

(3) Communications Port [COMT]

Device ype: Fortz [COM & LPT)

b arwfacturer: [Standard port typesz)
Location: on Intel[R] ICHAD O LPC Interface Controller -

Device statuz

Thiz device iz working properly.

[f paw are having problems with this device, click Troubleshoat ta
ghart the troubleshooter.

Troubleshoot. .. ]

Device uzage:

|lze thiz device [enable)

[ ok, l[ LCancel l

Figure 2.6 Enable Communication Port
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3. Communication Box

This chapter provides details concerning the Communication Box and how to place
recorder in the box prior to connection.

3.1 Communication Box

The DST Communication Box is a PC-RS-232C compatible communication interface,
specially designed to communicate with DST recorders wirelessly via RF (radio
frequency). A USB serial converter plug can optionally be used with the
Communication Box.

The Communication Box has three diodes:

1. Red - shows that power is fed from the power supply to the Communication
Box.

2. Yellow - shows that SeaStar has made connection with the box and that
correct COM port has been selected.

3. Green - shows that recorder is in correct position for seeking connection.

Connect the serial cable between the serial port of the computer and the
Communication Box. Plug the power supply connection to a power-socket. The
voltage from the power supply should be set to 9V, although there is no damage to
use up to 20V. Before inserting the power plug into the bo, it is important to note that
the polarity should be:

-(O+ (minus on the outside and the plus on the inside)

The polarity is usually shown where the arrows meet on the power plug, and the
power supply. After the power supply has been connected to the Communication Box,
the red light should be on. After SeaStar has been started, the yellow light should be
on (if correct COM port is selected).

The box will power the recorder while communicating with the PC. In case the battery
is dead, the PC and interface are still able to connect to the recorder and retrieve
data.

©2014 Star-Oddi. All Rights Reserved Page 11
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3.2 Connection Point

In order to get the green light, the red and the yellow light must be on.
The recorder is inserted into the hole of the box as shown in the figure below:

DST magnetic

‘/ Communication Box
—"1

L

Figure 3.1 Inserting Recorder into the Communication Box

If the recorder has been recording in the waters, then please wipe it dry before
inserting it into the box. The spherical end of the recorder faces down and flat end

faces up.

When the green light is on, communication can be established with the software.

If the recorder fails to connect, please refer to the Troubleshooter.

3.3 COM Connection
) Communication Definition [ =R li:z-

Select communication port

' COM1 " COM4

" COM3

Port enable / Power :-
+ ON
" OFF

oK

Figure 3.2 Communication Definition
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Choose Settings-Communication-Serial Ports to display available ports (see figure
3.2). Com ports up to COM255 can be selected.

3.4 Connection Wizard

Connection Wizard

If using a communication box:
Connect the box to the computer and insert the DST
If using a StarCom cable:
Connect cable between the recorder and computer

COM14 CcomM1

e

Figure 3.3 Com Port Wizard

Choose Wizards- Connection Wizard. Connect the USB cable and the selected
port will appear in the wizard pop-up window (see figure 3.3).

©2014 Star-Oddi. All Rights Reserved Page 13
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4. DST magnetic

4.1 General Description

Magnetic

The DST magnetic measures additionally to temperature and depth, compass heading
of the DST (with reference to the magnetic north) and tilt in 3-D three directions (with
reference to the Earth gravity). Tilt range is +/-90° for each of the three axis X, Y and
Z. The magnetic field is measured in three directions providing a relative reading of the
magnetic field strength at each point.

Compass heading measurements are compensated with the tilt measurements. This
enables good tilt compensation on compass heading and thus more accurate heading
readings.

The diagram below shows the measuring directions of the sensor relative to the DST
housing. In this position the heading (nose of housing) is Northeast (45°).

DST Magnetic

Figure 4.1 DST Magnetic

©2014 Star-Oddi. All Rights Reserved Page 14
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The performance of the DST magnetic is optimal when it is placed in the horizontal
plane, the further the magnetic pitches and/or rolls from the horizontal plane the larger
the error reading becomes.

To optimize the compass heading accuracy, the recorder needs to be placed
horizontally on the subject, having the nose facing in the same direction as the subject
iIs moving (for example if the DST is attached to fish, the nose of the DST should face
in the same direction as the nose of the fish). Normally the two holes should have the
same distance from the flat plane and housing text (DST magnetic or specified text)
face up. A mark on the end of the recorder’s flat end should face directly up. The data
are shown in degrees:

0° = North
90°= Easth
180°= South
270°= West

Other measurements in between, like 45° would mean N/E etc.

In the SeaStar software you can define if the data point resolution of the magnetic
measurements should be 4 point, 8 point or 16 point degree. This is defined under
'Settings - Preferences - Units'.

Select View-Data Trend and Table-Magnetic to view the magnetic axis and the
magnetic vector in nT (nanotesla).

Tilt

The tilt angles are referenced to the local horizontal plane, i.e., the plane perpendicular
to the earth's gravitational vector.

Pitch is defined as the angle between the recorder’s longitudinal axis and the local
horizontal plane (positive for nose up). Roll is defined as the angle about the
longitudinal axis between the local horizontal plane and the actual recorder orientation
(positive for right wing down).

In case the recorder is placed horizontally the following applies:

If the recorder is rolled to the portside, i.e. to the left (seen from the end where the
pressure sensor is) of the recorder, the Roll measurements are negative down to -90°.
If rolled to the starboard (to the right), the Roll measurements become positive up to
+90°C.

The Pitch axis rises positively when the recorder’s round end tilts up but declines
negatively when tilting down.

It should be emphasized that the pitch and roll angles that are calculated in SeaStar
are references to the horizontal plane and will thus not show the actual body rotation
of the logger unless transferred to PatternFinder where you can see the rotation of
the logger in animated form.

©2014 Star-Oddi. All Rights Reserved Page 15



User Manual SeaStar graphic Supporting Software

One thing that should also be considered is that the tilt sensor is fundamentally an
accelerometer and fast movements can give rise to erroneous tilt measurements.

4.2 Hands On Description

DST magnetic is calibrated at Star-Oddi, but it's possible that the sensor's direction
may differ slightly in other surroundings, including underwater environments. Therefore
it is recommended that the user performs reference measurements at the beginning of
a measuring period. For that purpose, please synchronize your own clock with the PC
computer’s clock, to see in which directions the recorder is placed at each time. If you
have a standard compass meter, it would be useful to do some comparison
measurements.

Also because the horizontal and vertical components of the earth's magnetic field vary
considerably in different locations it is possible to calibrate the compass in SeaStar,
under 'Edit - Reconvert Definitions - Compass Definitions' and put in an offset value
for declination (more on pages 47-48).

To understand declination it should first be realized that there are two North Poles.
There is a True Geographic North Pole at the top of the world, and a Magnetic North
Pole which is over 1,250 miles from the True North Pole. A magnetic compass like
DST magnetic always points toward the Magnetic North Pole. Maps are oriented to
the True North Pole. The angular difference between True North Pole and Magnetic
North is called declination. Declination varies from O to 30 degrees in most populated
regions of the world. These declination values usually change slightly over time, as the
Earth’s plates shift. The actual value of declination can be found on the internet (The
declination value can be found at
www.ngdc.noaa.gov/geomagmodels/struts/calclIGRFWMM). This will be expressed
as either an Easterly or Westerly declination, depending on your location.

The date-time, latitude and magnetic field vector should be noted at release and
recapture point. That information can be put in the SeaStar software under ‘Edit —
Reconvert Definitions — Deploy/Retrieve Location’. To correct/improve the tilt and
magnetic field calculations the user should enable that option. This will give more
accurate compass and tilt data.

4.3 Acceleration limit

Acceleration limit is an attempt to minimize the effect of acceleration exceeding the
earth’s gravitation.

The Tilt sensors are basically accelerometers and the tilt values are derived from the
acceleration measurements, thus if the sensor experiences acceleration beyond the
gravitational acceleration it can lead to extreme/erroneous tilt values. Sudden jerky
movements, knocks and bumps and much vibration can have this effect.

©2014 Star-Oddi. All Rights Reserved Page 16
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The nominal acceleration vector is used for comparison. For better readability the
nominal vector is displayed with a milli prefix as an integer.

The acceleration limit values are delta values 0-999. The default value is 100, i.e. 10%
of earths nominal gravitation.

Thus using the default value, if the acceleration vector exceeds +-1100 then XY and
Z acceleration values are exchanged with previously measured values.

©2014 Star-Oddi. All Rights Reserved Page 17



User Manual SeaStar graphic Supporting Software

5. Using DST magnetic - Tutorial

This chapter guides users in 8 quick steps through the process of utilizing SeaStar to
set up DST magnetic prior to recording and data retrieval.

5.1 DST magnetic Set Up

Step 1 - Start Program

Start SeaStar as described in chapter 1. Remember to carry out the software
preparation outlined in chapter 2.

Step 2 - Connect

Connect the Communication Box as described in chapter 3. Insert DST magnetic into
the hole in the box, and twist the recorder until the green light illuminates on the box.

Step 3 - Connect to the Recorder

Insert the DST into the box, the selected com port will turn green in the Connection
Wizard window.

Connection Wizard

Select the green com port

Figure 5.1 Connection Wizard

You can either click once on the selected port and select Next or double-click on the
port. If you are not using the wizard choose the Recorder menu and the Connect
command.

©2014 Star-Oddi. All Rights Reserved Page 18
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The window in figure 5.2 appears.

Connecting and Retrieving ID

Connecting to recorder 1 oK
Retrieving recorder EP-ID.. 0K
Testing recorder EP-ID for type.. oK

Confirming type & version.. 0K
Retrieving recorder RID.. 0K
Making CRC test.. oK
Created recorder data-directory:
E:ATesth71a8015UPYWS179

Making the MED file.. 0K
Retrieving RAM data.. oK
Making the MRD file.. oK
Testing power-down.. oK
Reading Clk-data 0K
Making the RID file.. (1]
Making the RIT file.. 0K
Making the RCI file.. 0K]

N

Figure 5.2 Connecting and Retrieving

Once the connection has been established, a window appears with information on the
recorder’'s mode (see figure 5.3).

Connection OK @

L ] i .
1 The recorder is on-line!

The recorder was in sleep mode

DK

Figure 5.3 Connecting to the Recorder

Press OK. The Recorder is now on-line, as indicated at the bottom of the SeaStar
window.

©2014 Star-Oddi. All Rights Reserved Page 19
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If you have selected to use the Connection Wizard, the following window appears:

Loggertypef|
‘me +Serial-numberf|
Battery-life.Place Type: DST centi = fogram and start
the-mouse-here-to- Serfal: C6430 — | recorder ¥~ | Program-and-
seethe-remaining: [~—sBattery Remaining: 87% | start-recorder
battery-life-in-%1 e Qﬁf | Retrieve recorder data
| 1 '
Memory Used: 0% L= ¥~ | Retrieve-
P— » j — Recorder-Dataf
memory.used“ Mode Status f“; SCO recor il -
4 g DisconnectRecordery
z :
P ,
RecorderModef| [ e
Status-of-Recordery | - —

(Jo:el

Figure 5.4 Connection Wizard

SeaStar checks which version of firmware is in the recorder. If the software does not
recognize the firmware the user will be asked to update SeaStar as there might be a
new functionality in the firmware which SeaStar does not support.

Connection Time Registration

Each time SeaStar connects to a Recorder, the PC time and recorder time is
registered to a binary file, with a CLK extension. This information is also saved to a text
file with the extension CCT.

Another text file is created with the extension CCD, containing various information, for
example on previous connection and time comparisons, depending on the status of
recorder.

If a previous CCT file exists and the recorder was in sleep or slumber mode, a PC vs.
recorder clock comparison is calculated, indicating difference in seconds and ppm.

If the recorder was in measurement mode, then a drift calculation is performed, based
upon PC-time comparison to the recorder’s clock and measurement sequence.

The RIT file contains partly the same information as the CCD file.

Upon retrieving date from a recorder and converting the data, the last measurement
retrieved time and the next scheduled measurement time is compared to the PC time.
The results are added to the CCD file and the MIT file.

Note: If the retrieved number of data does not match the last measured number of
data, erroneous results are to be expected.

©2014 Star-Oddi. All Rights Reserved Page 20
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Step 4 - Set New Measurement Parameters
(If the recorder has already been set up to record data and you want to retrieve data,
go directly to step 6).

Select Program and start recorder in the wizard and select which interval, single or
multiple, you want to use (see figure 5.5).

o~ ™

=)

(+ Single recording interval {default):

(" Multiple recording intervals

OK Cancel

Figure 5.5 Intervals

If you are not using the wizard choose the Edit menu and the New Measurement
Sequence Definition command. The following window appears:

) Set New Measurement Sequence | = | (S |-

Set start time

Start date: 9.11.2010 -
Start time: Hour ,@ Min m

Set measurement interval time:

Hours 0 :
Minutes 0 :
] 10 [=

Seconds

Primary / secondary - definition-
& TD-CompTilt normal

¢ TD as primary

¢ CompTilt as primary

=
Secondary counter: 0 =

Values allowed are 0,2,3,4.5..255

2 Node | EeerE
& Single mode

Use Default
" Multi mode

|~ Save this NMS definition as a Template (file]

oK

Figure 5.6 Measurement Sequence Definition

Select the start time of recordings (date-month-year, hours-minutes). The start time
of the new measurement sequence must be set at a minimum of three minutes in
advance. Set the sampling interval (hours-minutes-seconds).
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With default settings, Temp-Depth (TD) and CompTilt will be recorded at each
sampling (TD-CompTilt normal). The user has the option to select either TD or
CompTilt as a primary sensor. The objective with this feature is to save memory size,
increase recording period, and get more data on the sensor that is of more interest
(primary sensor). In this case, a secondary counter can be defined, which can only be
odd numbers. If for example CompTilt is selected as a primary sensor, and the number
3 is defined as a secondary counter, then TD will only be recorded every third time
when CompTilt is recorded, and the majority of the memory is used for CompTilt
recordings. If CompTilt is set as primary and secondary counter to O, then it is only
making Comp-tilt recordings, even though the first recording is always a CompTilt-TD
measurement.

If the user wants to program several recorders with the same sampling interval and
start time, it is recommended to select Multi mode. By choosing Multi mode, the
settings are fixed; giving each recorder connected to thereafter, the same settings.
The recorders connected to, following the first recorder, automatically get the same
settings as the first recorder. This saves time in the programming process. The multi
mode can be deactivated by clicking Cancel when connecting to the recorder (see
figure 5.4).

x

/ o The recorder “s new measurement sequence settings are:
| |

= Start time: 17.5.2011 16:50:00
Measurement interval [hms]: 00:00:10

Cancel |

Figure 5.7 Multi Start Mode

For programming more than one sampling interval, please refer to chapter 9.Multiple
Intervals.

The three buttons Use Template, Use Sequence, and Previous are not commonly
used, but can be handy when wanting to use a previously programmed sequence. To
read more about templates see chapter 8.13.

After the settings have been selected, press the OK button.
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Step 5 - Start a New Measurement Sequence

If you are using the wizard, the software will automatically start the new measurement
sequence (start recording) and disconnect the logger. If you are not using the wizard
choose the Recorder menu and Start New Measurement Sequence command. The
window in figure 5.8 appears.

Start New Measurement Sequence

Figure 5.8 Start New Measurement Sequence

Once the new measurement sequence has been downloaded into the recorder, a
window appears on the screen in order to verify the settings (see figure 5.9).

Start New Measurement Sequence Activation |X|

The recorder’ s new measurement sequence settings are: 9 }
-

Start time: 02/06/2003 14:31:50
Meazurement interval [hros]: 00:00:10

L 1]4 ” Cancel ]

Figure 5.9 Start New Measurement Sequence

Press OK and the recorder will be in Measurement Mode.

NMS Calculation

Upon setting up a NMS the estimated measurement sequence is calculated and
memory and battery energy usage predicted. The results are written to a text file,
bearing the recorder name with a NMS extension. If a recorder has not been selected
then the file bears the recorder type name, still the NMS extension.
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The file is placed in the SeaStar\NMS directory. An example of the *NMS file is
shown in fig. 5.10.

U8 S WOMALI1 19 MM SR

Figure 5.10 Results from NMS Calculation

When starting the recorder in a NMS, the *RDT file shows the sequence settings,

plus information on the sequence time duration and battery usage (same as in the
*NMS file).

Step 6 - Retrieve Data

When connecting to a logger after a measurement period, the following window
appears:

—

Retrieve recorder data?

[~ Remember this setting

Figure 5.11 Retrieve recorder data

Click Yes if you wish to retrieve the data, click No if you would like to retrieve it later.

If you want the software to automatically retrieve data upon connection, check the
Remember this setting option.
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Select Retrieve Recorder Data in the wizard or choose the Recorder menu and the
Retrieve Data command. The following window appears:

Retrieve Data from Recorder

Aetreving 1ecorder 1D OK
Tasting 1D 0K
Aetimving doa Ok
Making the 1. MIT fie Ok
Corvestrg e data 0K

Bytes recenad 5000 of 5000
Time (mn'sec) 047 of 052
Packs received 20 of 20
FHesant packs ]

Recene emoes )

Cancel dats retrieval l

Figure 5.12 Retrieve Data from Recorder

The window in figure 5.12 shows the data retrieval progress in bytes, time elapsed
and number of packs received.

Data will be uploaded from the recorder and presented in graphical and tabular form.
With default settings, SeaStar automatically creates a sub-directory in the Seastar
directory, named DST magnetic. In the DST magnetic directory, a directory named
after the recorder’s serial number (Qnnnn) is created. All files related to the recorder
are automatically saved in the serial number directory. The default data directory can
be viewed in the Settings menu, and Directories. The user has the option to define a
new data directory path if desired.

The data is retrieved in a non-destructive manner. This means that you can repeatedly
read the data without erasing it from the memory. Each time data is retrieved, a new
file will automatically be created. The name of the data file consists of the
measurement sequence number and the serial number of the recorder. The recorder
cannot be loaded with new settings if it contains data that has not been retrieved. This
is a safety feature which prevents data from being accidentally lost. New recordings
overwrite previous recordings that have been retrieved.
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Once the data has been retrieved the following window appears:

= ~

Recorder Wizard

Type: DST centi
Serial: C6439

Battery Remaining: 87% Coa
LTI e Restart recorder with the

Memory Used: 0% \ same sampling interval

Program and start recorder

Mode  Status o1l Retrieve recorder data

S o

Recorder was in measurement - Kg_k Disconnect recorder

mode

Figure 5.13 Recorder wizard

If you wish to start a new measurement sequence you can either program the logger
with a new measurement sequence by selecting Program and start recorder or
Restart recorder with the same sampling interval.

Step 7 - Disconnect

After the recorder has been set up for measuring, it should be removed from the
Communication Box. If the recorder is not put in measurement mode, it will
automatically go into sleep mode when removed from the box.

If you simply remove the tag SeaStar will still have the recorder in on-line mode in the
program and won't allow selecting another recorder or using certain options. Select
Disconnect Recorder in the wizard or Recorder > Disconnect to go into off-line
mode.

Step 8 - View Data

If data is retrieved from the recorder, a new file will automatically be created and
opened in graphical and tabular form. To open existing data files on the computer,
choose the File menu, Select Recorder command, and then the Select
Measurement command. When a data file has been opened, a new window appears
with the data shown as a chart and a table. The next chapter will describe in detail
how to view and process data.
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6. View Data

This chapter describes how to open a data file and the options available in SeaStar
for viewing the data.

6.1 Open Data
To open an existing data file that has already been retrieved, do the following:

1. Choose the File menu and the Select Recorder command. When a recorder
has been selected, its serial number will be displayed in the blue top bar of the
software.

2. Select the data file by choosing the File menu and the Select Measurement
command.

The name of the data file consists of the measurement sequence number (number of
times the recorder has been set up to measure) plus the serial number of the recorder.
The ‘Measurement sequence no.” can also be seen at the bottom in the SeaStar
window. When the data file (.mid) has been selected, the chart and data tables are
opened. The following figure shows a chart and data table which have been opened:

Tempeera™

Phoss smar wiwi  Lusel

Figure 6.1 Chart and Data Tables of an open File
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Import

Data files from other recorders than DST can be imported into SeaStar and viewed as
charts and tables. The imported file must be a text file with the extension DAT, and
with SeaStar’'s conventional DAT file structure. See more about data files and headers
in the Appendix.

Buttons
When the chart is opened, buttons related to the chart are displayed.

2

Active Series List

This button can be useful when working with a multi-sensor recorder, in order to
select which parameters to display in the chart. Click the button and the following
window appears:

= =

L Series List =5 ESB =X
&)ﬁ [V — Temperature(°C)
0K
m [V — Pressure(Bar) —I
P ¥ — Tix()
@ V — TitY()
P ¥ — Tiz() Only show
tive tabl
pix ¥ — CompHead(’) = e
@_7(_’ v Comp.4p(*)
@ V — Inclination(*)
iz v —|

Figure 6.2 Series list

By selecting Only show active table columns only the selected series will be
displayed in the chart table.
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The table columns can also been changed manually by right-clicking on the table (see

figure 6.3).

Numberl Time ITemp("C)lPress(Bar)J
.1 1 14,1,2009 14:47:00 -314,056 -13,48
m v lember I
Jii 3/14.1.2

4(14.1.2 ¥ | Time
i 514.1.2 v Temp(°C)
=] 8 14'1‘2; v Press(Bar)
714.1.2 3 &
il 8 14.1.2 v Tfk'x()
31412 ¥ TitYC)
| w412 v TiR-Z()
N 11 14.1.2§ v Comp.H(%)
— = 14'1'21 v Compdp()
j 1 13 14.1.2i 4
[ aafiaid Y| Bew)
15 14.1.2 Mag.vec(nT)

Figure 6.3 Table

Horizontal/Vertical Gridlines
These two buttons give the option of hiding/displaying the horizontal/vertical gridlines

in the chart.

A drop-down menu appears when clicking the horizontal gridlines button.

Select the series gridline.

Off

v Temperature(°C)

Pressure(Bar)
Tilt-X(%)
Tilt-Y(%)
Tilt-Z(%)

Comp.Head(%)
Comp.4p(°)

Inclination(®)

Figure 6.4 horizontal gridlines
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A drop-down menu also appears when clicking the Vertical gridlines button

u
Off

@ Auto
Minute
Hour
Day
Month

Year

Figure 6.5 vertical gridlines

Select the minimum grid size.

|

Data Point Marker
This button gives the option of displaying/hiding data points in the chart.

=

Histogram

The chart can be shown as histogram, displaying the distribution of values by
percentage.

Click the Histogram button and the following window appears:

r =
Hsogram and data statstics o

Temperature"C) =
-~ & Defus

€ Usey
3%

Figure 6.6 Histogram and data statistics
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Under Bin Settings there are two options, Default and User. Choose User to select
the number of bins and the minimum and maximum values you wish to display.

The Histogram can be printed out by clicking the Print button.

H

Save Window Data

Retrieved data is automatically saved, but if changes are made with the graph, for
example with the time scale, the save button enables the user to save the graph (as a
DAT file).

-

Print
The chart can be printed. For more details see chapter 7.Printing.

&

Zoom Out
Click this button to zoom out the chart.

»

Zoom In
Click this button to zoom in on a previous view.

A

Adjust Axis

This button adjusts the axis in order to display all data within the zoomed timeline.

Open file in PatternFinder
Click this button to transfer data to PatternFinder
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Chart Edit

By clicking this button, the following window appears:

-~ Series ~

TimeLine
Temperaturel=C)
Pressure(Bar) Farmat ‘P'Z'il'lt ]
Tilk-2(=
Tilk-¥{*) Border...— | | Dark 3D
Tilk-2()
Comp. Head(®) Color. .. [ Color Each
Comp.4pi®)
Inclination;®) Pattern. .. [v Clicksble
- Chart Height 30: 0 =
+- Bxis
+- Titles Stack:  Mone
Legend
Parel Treat pulls:  Dont Paint
Pagin
o v

@ Line: TimeLine

Line Maode:
[v 5tairs

| Inverted

Qutline. ..

L

[vw Color Each line

Shadow. ..

Gradient...[ |

i

Close

Figure 6.7 Editing Chart

This button gives several options regarding the look of the graph. The axis can be
defined (max and min), titles and legend can be set visible. Under ‘Panel’ the color of
background, borders and gradient can be selected. Under ‘Walls - Back’ the colors
and gradient of the graph itself can be selected. The ‘Visible’ option must be enabled
to activate the features. The graph can be exported in formats as jpg, gif, bitmap,

metafile, pdf, htm and svg.

Templates

Templates

If the changes have been made to the graph under ‘Chart Edit, it is possible to save
that template. It is also possible to load a previously saved template.

' Display table completely

3
Partial table display

“ Hide table
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Using the Mouse

Max and Min Values

Click once on any line in the chart, and the maximum and minimum values for that line
(sensor) are now shown. A straight vertical line should be visible in the graph (to the
left). By clicking on this line and holding the left button on your mouse down, the line
can be dragged through the chart and the data table will scroll along with the position
of the line.

Zoom
The chart can be zoomed in by holding down the left button of the mouse, and using
the cursor to create a box to the right, around the desired area to zoom in on.

Scroll the Chart
The chart can be scrolled upward, downwards and to the sides, by holding down the
right button of the mouse and moving the cursor in the desired direction.

Go Back to Initial View

To go back to the initial view of the chart, simply hold down the left button of the
mouse and make a box to the left with the cursor. The position of the box on the chart
is irrelevant.

Change the Axis
By double clicking on the X and Y-axis, the measurement time and temperature/depth
range can be changed.

Change the Title
To change the title of the chart, double click on the title of the chart

6.2 The View Menu

When a recorder has been selected, the files in the View menu can be opened.

Data Trend and Table

This view is automatically selected when data is retrieved or a data file is opened. If
the chart is closed, but a recorder has been selected, this command can be selected
to view the chart. The software will open the latest chart that was viewed for that
recorder.

Acceleration

Select View-Data Trend and Table-Acceleration to view the acceleration.

The *.A90 file

Tilt measurements are basically calculated from acceleration to +/-90° on all axis.
Viewing the tilt values in a +/-180° system is more natural. The 180° can be arrived to
via calculation and this is used in SeaStar.
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In order for the user to view the “underlying” 90°ilt system, a file with the extension

A90 can now be viewed in SeaStar, graphically and as a text file. The 90° tilt values

for the three axis X,Y and Z are represented as well as the different values after

acceleration limiting and boundary round off.
An example of a *.A90 is shown in figure 6.8.

® C:ASEASTARDST MAGNETIC\J0047\4\3-4J0047A%90

E =l v Ghart 00 ma-!-_j R P
147004740 s | Tow [eocfraxnfrsoc oo vomemeoma] <
A 4,90.2011 0% 4:17 . 40 3 A 0 ¢
[ =ssanmionsgr ) ) t ™

™ Lal 3 2 Y 2 0 s 2 0

@0 ol [] seraaiz M:17 2l 3 ] s

© e 3D 431,301 0 M1 38 1 o ) 5 0

a R E 12,7011 08:2 » 2 1 0 i

v 4 X0 4.3 i1y 2 0 -

% i W7 0 : 0 0 )

. C b | w2 0 i1y A 2 ! ) b a9
T | f il | 3 4,22.20 w1 . 2 ) ) ® o
=aof--H+1H 4t HE Ll H - i P P Gy e A

o It 11 il * 1 ™

- i i : x 1 I

s f ! » ¥

= I [Ls 2 o 2 : 5

ol | 2011005 - ) 5
'!: “ ' ’ !A!A ' A!A;‘ r 11,2001 9317 - . 0 L)
— | 1120110 M:17 90 ) 1 &
SN U 12,3011 09:4:17 %0 2 a B
Tiews-Werdow atisties far 3900%)
Mo T4 09T Vv 30 o DMUT Merng: 95,45 - - > -
. . . °
Figure 6.8 Tilt values in the +-90° system

Binary Magnetic Data

In order for the user to verify the temperature correction a *.BMD file is created that
contains the original data as well as the difference between the original and
temperature corrected data. See figure 6.9.
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Figure 6.9 Original Ur,Vr,Wr and difference Ud,Vd,Wd magnetic values.

Recorder Information (RIT)

This is a text file containing basic information about the recorder, serial number,
production date, estimated battery life etc.
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Recorder Calibration Information (RCI)

This text file contains information about the calibration constants of the recorder,
calibration range of the parameters. The range is both showed as decimal values (DV)
and unit values (UV). The survival depth of the recorder is also shown.

Recorder Download Information (RDT)

This text file contains information about the measurement sequence that was last
downloaded into the recorder, including the start time, sampling interval and the
measurement sequence number.

Viewing Text Files

Under <View\Text files> the user can select a text file, via a file browser, for viewing.
This option is meant to give the (advanced) user a chance to view files that are not
directly supported for viewing in SeaStar, but are a part of the SeaStar documentation
system.
The files that the file browser accepts must have the following extensions:
o TXT
Frequently, users copy SeaStar data to text processors and spreadsheets, like
Word and Excel, and later save the data as TXT files for viewing in other
applications.
e INI
There are a number of INI files that SeaStar uses for store settings. These files
are described in the Appendix under ‘Information files’. The latest members in
the INI files family are the Template files.
e DAD
This is the original data file. It contains the raw data (in Ascii format) retrieved
from recorder. The DAD together with the MID are converted to the DAT file.
A word of warning: The DAD file should never be tempered with, as that might
give cause to erroneous data conversion.
e CCT
Every time SeaStar connects to a recorder, the PC time and the recorder’s
clock data are stored in a <recorder name=>.CCT file.
e CCD
Every time SeaStar connects to a recorder, the PC time and the recorder’s
time are compared to the last CCT, if found, and stored in <recorder
name>.CCD file, <measurement sequence name>.CCD.
e NMS
Upon completion of a NMS editing session, estimation of memory and battery
usage is calculated and the results placed in a NMS file, which is then
displayed to the user.

SNMS LOG File

To improve the “Start New Measurement Sequence”, SNMS, indication/registration of
success or failure, a log file for each recorder type is placed in the SeaStar directory.
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The log file name, for DST magnetic, is DSTJ.LOG, i.e. the same naming convention
as for the type INI files.

Each time a SNMS is performed then the appropriate LOG file is updated.

The LOG file can be viewed via “View\SNMS Log file (LOG)".

In addition to the LOG file, if an error occurs during the SNMS, the MDD file is
created as a text file, with a description of what went wrong. This MDD file is
displayed as a clear message for the user as shown in figure 6.10.

Recorder number oQoozy
Measurenent sedquence number @ 6
Attenpted SMMS Date and Time: 3.12.2006 15:44:17

4 conmunication error occured when
transfering new settings to the recorder

Fleasze note that the recorder was NOT started !
Please try again.

e

Meas.sedq.

Figure 6.10 The MDD SMNS Error Message

Usually the MDD file is a binary file, and the MDT is created from the MDD. If the
SNMS is repeated successfully the MDD file is overwritten and the MDT file created.

Measurement Data

Measurement Download Information (MDT)
This text file contains information on data downloaded into the recorder for the
measurement file being viewed, including the start time and sampling interval.

Measurement Information (MIT)
This text file contains information concerning the measurement upload time, start date,
start time and number of measurements in the measurement data file.

Conversion Information (CIT)
This text file contains conversion information on the units and the data file format.

Statistics in CIT

The CIT has been enhanced with more detailed information on the converted data.

As can been seen in figure 6.11, the statistical data, that have been tabulated, are split
into two sections, the Unit values statistics and the Decimal value statistics. Values are
given for each parameter. The file can be viewed under ‘View\Measurement
Data\Conversion Information (CIT).

A one line description/comment is available for the user to fill out in the Reconvert
data menu. This description is placed in line two of the CIT file.
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Figure 6.11 Statistics in CIT File

Out of Range (OOR)
This text file lists all the measurements that were outside decimal value calibration
range, as well as the unit value range. If correction has been performed according to
the user definition, then the corrected values are shown. See more in chapter 8.7.0ut

of Range.

Binary Data (DAB)
This file contains raw data of the measurements in the data file. Calibration files are
not calculated into the data.

View DAB Files as Trend
When converting the DAD -> DAT the DAB file is created simultaneously.
The DAB shows the recorder’s native data, i.e. decimal values in the range 0-4095.
These values originate from the recorders 12 bit ADC (Analog to Digital Converter).
It can be of interest to view the data in its native form, for example to spot
saturation/out of range intervals.

The DAB can be viewed graphically as a trend via:
‘View\Data Trend and Table\Decimal (Binary) data (DAB)’ (figure 6.12).
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SeaStar cannot view older DAB files, and will inform the user to that effect, if an
attempt to view an older DAB file is performed. By reconverting the data, a viewable
file is produced.

Figure 6.12 DAB Trended

Binary Pressure Temperature Corrected Data (BPD)
Pressure measurement circuitries are calibrated against measurement errors due to
temperature changes.

Raw decimal values from the recorder can be seen in the DAB file. The first step in
converting decimal values to unit values is the circuitry temperature correction. The
result of this first correction can now be seen in a new file in SeaStar, *.BPD. The file
contains the corrected decimal value and the difference between the original value
and the corrected one.

The file can be viewed graphically or as tabulated lists.

Converted Data (DAT)
This is the text file for the converted data. The DAT file as well as the other text files
can be opened in other programs (Excel, Notepad, Word etc.).

Time Synchrone Data (TSD) and Rate of Change (ROC)

If the TSD and/or ROC file creation has been enabled under the Settings menu, then
it's possible to view these files.

You can find more in chapter 8.8 TSD and chapter 8.9 ROC.

You can find more about files in the Appendix.

SeaStar Log

SeaStar stores events in the file <SeaStar.log>. The events are:
e Recorder Connected
e Retrieving data from a recorder
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e Uploading a measurement sequence to a recorder

e Recorder disconnected.
This file can be opened in SeaStar under <View/SeaStar Log> or by opening it with a
text editor.

Screenshots

By pressing the Print Screen keyboard button while in the application a screenshot of
the desktop is taken and stored in a subfolder, Screenshots.

The user can name the screenshot file as can be seen in the following figure.

Set filename

|r~'1':.:'5n:reen5hnt

| K | Cancel |

Figure 6.13 Name the Screenshot

The screenshots can be viewed in View-Screenshots or by browsing the screenshot
folder, <\SeaStar\ScreenShots\>.

The button also performs its normal operation which is to store the screenshot in the
clipboard.

6.3 Opening Data in Excel

When retrieving data, the SeaStar software automatically creates a text file with the
data, called *.DAT. This text file can be opened in Excel and in other programs.

Under the ‘Settings’ menu, ‘Preferences — Data File Format’, the default factory
settings is set to ‘joined date and time’. If this option is not disabled, the following is
performed, for opening data in Excel:

1. Excelis started.
2. The *.dat file is found from ‘File/Open’.
3. Excel comes up with the ‘Text import wizard'. This is a three step process:
a. No changes should be made in first step, so press the next button.
b. ‘Text qualifier should be set as ‘None’.Press the next button.
c. Column 2, that is date and time, is set as ‘Text’. Press the finish button.
4. You can now create the graph with columns B, C and D.
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7. Printing

All charts and text files can be printed from the SeaStar software.

7.1 Charts

Open the chart you want to print out and select File-Print on the menu bar. The
following window appears:

[ |
() TeeChart Print Preview | ﬂ—@@‘
Printer: HP LaserJet 2420PCLSe v  Setup... print | [ close |
~Orientation: i
" Portrait

' Landscape

Margins (%) al
i |
23 =1

[V View Margins

Detail:
| More Normal

—

MamuwBOER NN EMY
WHE NN NRRRRERNN

IV Proportional
[~ Smooth

Figure 7.1 Print Preview

Orientation
The chart can be printed in either portrait or landscape format.

Margins

By changing the margins, the chart’s length and width can be re-scaled. The margins
can be varied by either changing the numbers given for the left, right, top and bottom
margins, or by moving the margin lines with the mouse by pressing and holding the left
button as the lines are dragged.

Move

When the cursor is located on the chart, a hand becomes visible. By clicking on the
chart and holding down the left button of the mouse, the chart can be moved around
the page to a desired position.
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Details

The size of horizontal and vertical gridlines as well as the texts on the X and Y-axis can
be re-scaled by using the scroll bar. The number of gridlines is increased when the
bar is moved to the left.

Another way of printing out a chart is opening the chart you want to print out and
clicking the Print Chart button on the chart bar.

7.2 Histogram

To print out a histogram, open the chart which histogram you want to print out and
click on the Histogram button on the chart bar. The following window appears:

-
Hogram and data statstcs

Seect On Setings

el L I e e
WOET. AT WS008 I TI.N 40

Crte Statytey
Mo 8047 Mae: 33410 Rage: 3364
Ve 28,367 Vedard 22,191 Fons: 6424
S, Dewt 953 Variance! 200 Voce: 2. 154

nt Oose

Figure 7.2 Histogram

Click Print and the window in figure 7.3 appears:
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-
Output Options

)

—Selected Printer
HP LaserJet 2420 PCL Se

—Report Destination
" Printer

—Options-
Copies I Collate

|1 I Dupiex

¢ Preview Cancal |
(“ 5:_\‘«.; I iﬂ]
Format:lRa'.ve Snapshot File lr'c'[_'_] S-et"'p |

Figure 7.3 Output Options

To change the selected printer, click Setup and select another printer.

To see a preview of the print out, select Preview under Report Destination and click
OK (see figure 7.3 and 7.4).

W Nepart Prwewe

foe VPoge Zoom

Sl G 1w > Page [ ol | B A B Zoom i % B

L) SeaStar

WADIC 1ISEN

Histogram and Statistics
File nama: CHSEASTARIDAT CENTMCOS03CO503 DaT

Time range: 13 2 2003 000000 to 2 92 2004 10 40 90
Measwrements. | o 50457

Temperatwe("C)

- —

J 883 .7 8 12508 . 17 A2 J26N .7 TN

Data Statistics

WMin 2402 Ma 27730 Range 25,332
Maan =806 Medtan £ 298 Panis 52348
e Dev 2842 Vanance 6970 Node ¥ 204

Figure 7.4 Report Preview
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7.3 Files

Activate the file you want to print out and select File-Print on the menu bar. The
following window appears:

-
Output Options M

—Selected Printer-
HP LaserJet 2420 PCL Se

r—Report Destination
" Printer

{* Preview
e fiwfl

Format:lF:a.‘e Snapshot File (.';Z;] ‘ Setup |

—Options-
Copies i

Figure 7.5 Output Options

The dialog window in figure 7.5 has the same functions as the one in figure 7.3.

Note that as some of the files are very large, it is recommended to highlight the data
you want to print out before printing.

r 2
Y Bepor Nieare = _as

tie Fage Zoem

=1V ML > Page [t THLTTY ™ 'Y |

) SeaStar

C:\SEASTAR\DST CENTINCO50311C0503.DAT

Figure 7.6 Report Preview
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8. Settings

This chapter describes the options in the Settings menu. These settings are
automatically saved when exiting the program.

8.1 Directories

The path definition can be set as Default SeaStar path structure or User defined
paths. Choose the Settings menu and the Directories command. A dialog box
appears:

() Path Definition l = | B (S

Set path definition as:

+ Default SeaStar path structure:

" User defined paths

Default SeaStar path structure

Data directory: C:\SeaStar\DST magnetichnnnn

Type directory: C:A\SeaStar\DST magnetic

User path definitions

Data directory l C:\SeaStar\DST magnetic

L]

Description l _]

0K ] Cancel l

Figure 8.1 Directory Path Definition

Default SeaStar Path Structure

By choosing DST magnetic as a recorder type, SeaStar automatically creates a ‘DST
magnetic’ type directory in the ‘SeaStar’ directory that was created when the software
was installed on the computer. Upon connection with DST magnetic, another directory
is automatically created in the ‘DST magnetic’ directory, which is named after the
serial number of the recorder.

All data files and other files related to that recorder are stored in this ‘serial number’
directory. Each DST magnetic recorder has its own data directory.

User Defined Paths

If this option is selected, the User definition data directory becomes active. The data
path/directory can be defined by the user. For defining a path on the network, the
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particular drive must be mapped (under Windows Explorer) in order to browse for the
drive under ‘Add data path’.

Browse First in User Directory

With default off, the user is first directed to the path where SeaStar was installed, to
look for the INI file. If this option is enabled, SeaStar will start looking for the INI file in
the user-defined directory. More information on files and directories can be found in
the Appendix.

Create Recorder Directories

This option is default on, and means that a recorder type and serial number directory
is created for every recorder connected to.

8.2 Preferences

Units
By choosing the Settings menu, the Preferences command, and Units, a dialog box
appears:
Units ==
Temperature units: Number of decimals(0-4]:
(¢ Celsius ['C) " Fahrenheit [°F] 2 -
Prassira s Number of decimals{0-4)
(% Pressure (Bar) " Depth (fthm) 2 A
" Depth [m) " Pressure [psi)
Number of decimals: (0-1)
Tilt units are {(-30°<->90%) 0 %
Compass units are (0°<->360°
Compass definition
¢ 4 point compal " 8 point compal™ 16 point comp
ok |
Figure 8.2 The Units Dialog Box
Select Units

The user defines whether degrees Celsius or Fahrenheit are used as a unit for
temperature measurements. The pressure measurements can be displayed as
pressure (bar), depth (m), fathom (fthm) or PSI. Number of decimals for the values can
be selected. The magnetic heading is default set to 4 point compass (N-E-S-W) but
also possible to increase it to 8 or 16 point compass.
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8.3 Data File Format

By choosing the Settings menu, the Preferences command, and Data File Format, a
dialog box appears:

) Data File Format li?gl
Date format Date separation
) o Dat [)
(& dd mm yy
— &
i Slash [/)
" Dash (]
Time separation- Field separation
& Colon[:) & Tab
" Dotf.] " Space
Date and time column definition Select decimal point:
¢ Joined date and time & Commal,)
(" Seperate date and time " Dotf.]
Cancel

Figure 8.3 Data File Format Dialog Box

Date Format

The user defines whether the date should be shown as dd mm yy (day, month, year),
or mm dd yy (month, day, year).

Date Separation

The user defines whether a dot, slash or dash should be used to separate the date.

Time Separation
The user defines whether a colon or a dot should be used for the time separation.

Field Separation

For the text files created, the user defines whether a tab or a space should be used to
separate the fields.
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Date and Time Column Definition

If data is to be exported to other programs, it is recommended that the date and time
be joined in one column.

Select Decimal Point

The user defines whether a comma or period is used for the values displayed in
SeaStar and for text files that are created.

8.4 Connection

Choose the Settings menu and the Connection command. A dialog box appears:

= ~

I} Connection Options

v Perform CRC test when retrieving RID:

v Check Data Echo in SNMS and updating settings in
Disconnect and Retrieve Data

If data is in the recorder then:

" Don't retrieve the data automatically
" Automatic data retrieval upon connection

(& Ask user whether to retrieve the data

fv Perform Comparison test on RID in SNMS

[ Using a StarCom cable

0K Cancel

Figure 8.4 Connect and Retrieve Data Options

Perform CRC Test When Retrieving RID

The CRC test is a safety check performed by the software when retrieving Recorder
Information Data (RID). If the CRC test is not successfully carried out, it means that
some errors have occurred in the transfer of files or constants, between the recorder
and the computer. If a CRC test failure occurs, the user is notified. This option is
enabled by default but if disabled there is a risk of errors in the constants.

Check Data Echo in SNMS

Normally the Check Data Echo in SNMS and updating settings in Disconnect and
Retrieve Data should be enabled (figure 8.4). In case of communication problems
using a USB serial converter the user can try to disable this option, as it will bypass
data echo checks, resulting in less restriction on communication protocol.
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If data is in the recorder then:

Don't retrieve the data automatically: If this option is enabled, data retrieval is done
manually via the recorder wizard or by choosing the File menu, and Retrieve Data
command.

Automatic data retrieval upon connection: By enabling this option, the software will
automatically check for data in the recorder upon connection and retrieve it.

Ask user whether to retrieve the data: By enabling this option, you will be asked
whether you want to retrieve the data or not each time you connect to the logger.

8.5 Retrieve Data

Choose the Settings menu and the Retrieve Data command. A dialog box appears:

i) Retrieve Data Options — S|

Retrieve number of data according to:

* Last saved number of byte: 0
Equivalent number of measurements 0

" User defined number of byte

" The whole recorder memory: 261575
Recorder capacity:  Byte 261575
:Measurements 29062

oK

Figure 8.5 Retrieve Data Options

Retrieve Number of Data

With default settings, the software retrieves the last measurement sequence recorded.
The user has the option of retrieving older data that is still in the recorder’s memory.
By choosing the User defined number of data, the number of measurements
retrieved from the recorder can be set. Memory capacity is 20,120 measurements per
sensor compass, 3-D tilt, depth and temperature (261,575 bytes).

As the complexity of measurement intervals give incoherence in the calculation from
measurement number to the number of data byte to retrieve, the user has the option to
define number of bytes to retrieve.

If for some reason or another it becomes necessary to retrieve data more than once or
even several times, the previous DAD and MIT files are not overwritten before a
backup has been made. The backup files are in the same directory as the “original” or
the last DAD file.
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A backup number system is in use that marks the first retrieved file as number one, the
second number two etc. The number sign #, is used to identify the backup up files.

Thus if a data file has for example the name 25M1106.DAD then the backup file, that

was the first retrieval, gets the name 1#25M1106.DAD, and the 25M1106.MIT file
that is associated with the DAD file, is backed up as 1#25M1106.MIT.

8.6 View Data

Choose the Settings menu and the View Data command. A dialog box appears:

L) View Dats Definition o -5 |3

[ View Data Trend (*.DAT) after Conversion

7 Miew Data Trend [*DAT] after Measurement Sequence Selectioré

v View Data Trend (*.DAT) after ReConversion
[ View Time Synchrone Data [*.TSD] after ReConversion

[ View Rate Of Change data (*ROC) after ReConversion

[~ View Online data as BIN

OK | Cancel |

Figure 8.6 View Data

Select View Data Trend after data retrieval/conversion to view the data right after
data retrieval.

Select View Data Trend after Measurement Sequence Selection to work with
measurement data while offline.

With all the options in SeaStar, the user may want to do a lot of reconverting
(<File\Reconvert Data>) on data files after defining the preferences; changing units,
data formats, OOR settings, TSD settings, ROC settings, offset settings and
converting different sections of the data file, all of which result in numerous files. To
ease the task of remembering settings and results and/or renaming and copying files,
a backup system of reconverted files has been implemented.

A reconvert number is now associated with each sequence. This number is saved in
the recorder’s INI file and updated each time a reconvert is implemented. A copy is
made of the DAT, CIT, DAB, OOR, TSD and the ROC files with the reconvert number
attached to the filename.
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Thus if a data file is for example named 5Q1024.DAT, then after the first reconvert, a
copy of the DAT is named 1-5Q1024.DAT, and the same naming convention is
applied to the other files.

Each time data retrieval is performed, a subdirectory, which name is the sequence
number, is created in the data directory, where a copy of the “original” DAT, DAB, CIT
and OOR files is placed. These files have a “0-" in their names. All the reconverted
files are placed in the sequence directory. The reconvert number system is optional,
and the user can disable it in the reconvert menu. When the reconvert number system
is in use, and when viewing trended reconverted data, the reconverted “backup” file is
displayed, thus eliminating the need to close the “last” converted trend data window.

8.7 Out Of Range

If measurements are outside the calibrated range, they are less accurate. The out of
range measurements (if any) are shown in the OOR file (View — Measurement Data —
Out Of Range Data). For example when depth measurements are outside the first
calibration range (at very shallow depth or in air) the data may look strange and the
user may want to set those data to 0.

Choose the Settings menu, Out Of Range - UV and DV definition command. A
dialog box appears:

() Set Out Of Range (OOR) Parameters == |@
Decimal values (0-4095) Unit values
Min Max Min Max
Temperature |10 ;_1 [E#f,-’t ;_} ,—5 _:_‘ |55 ;j (-10 - 120 *C)

Pressure |10 ;j |4090 :}

»
o
4

|900 2| (0-3000m)

Default
(1] | Cancel I Previous

Figure 8.7 Set Ranges for the Parameters

The Unit Values (UV) ranges can be set, eliminating all values that are outside the
calibration range.
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Decimal Values

Decimal Values (DV) are raw measurements, sometimes referred to as binary data.
The decimal value is between O and 4095, which is the range for the 12 bit AD
converter. The decimal values are the recorder’s calibration range. The user should not
define the decimal value range, unless he has obtained these values for that particular
recorder from Star-Oddi.

Unit Values

The decimal values are converted to Unit Values (UV), for example a decimal value of
2000 could give 20°C. The user can select a specified range for the parameters. If
unit values in the data are outside the measurement calibration range of the recorder,
the user has the option to set a max and min range for these unit values. After
selecting the unit value ranges and pressing the OK button, the following window

appears:
OOR Correction l—}E-]
DV-Correction- UV-Correction-
{* No Correction ¢ No Correction
" Last Value " Last Value
" Max/Min DV-limits " Max/Min UV-imits

Cancel I

Figure 8.8 Out Of Range (OOR) Correction

If no values have been selected for the Decimal Value (DV), ‘No Correction’ should be
selected for ‘DV-Correction’. If Unit Values (UV) ranges were specified, the user has
two options:

1. Last Value: Change the out of range measurements to the last value that was
recorded before the out of range measurement was recorded

2. Max/Min UV-limits: Change the out of range value to the max/min unit value as
specified earlier. In this case the software will know if the value is under the
minimum or maximum limit.

The data needs to be reconverted under ‘File — Reconvert Data’ after the correction
has been made (after pressing OK) and data will be changed accordingly. You can
find more about reconverting in chapter 10.
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8.8 Time Synchronous Data (TSD)

Choose the Settings menu, TSD definition command. A dialog box appears:

Time Synchronous Data Settings &J

[ Make TSD file when converting DAD -> DAT

Sample Interval

¢ 1Hour
" 10 Minutes
" 5Minutes
" 1Minute

[ Indude empty cells

Cancel

Figure 8.9 Time Synchronous Data Settings

If the user wants to time synchronize two or more data files, it is possible to select
three options: 1 hour, 10 minutes, or 5 minutes. The restriction is that the sampling
interval selected must be greater than the initial interval, and it must also be dividable
by the initial interval. For example, if the initial interval was 15 minutes, only the 1 hour
option can be selected for time synchronous.

If the ‘Include empty cells’ is enabled, the data tables will be empty for those
measurements in the original file that are not to be shown.

If the user wants to activate this feature, the ‘Make TSD file when converting DAD-
DAT' must be enabled. For changing the current measurement file with one of the
three intervals, the data must be reconverted by ‘File — Reconvert Data’.

8.9 Rate Of Change (ROC)

This new feature gives the user a chance to see how fast the signal is changing, i.e.
the estimated velocity of the signal. This applies to all measured parameters. The ROC
is calculated via a two point numerical differentiation:

ROC= (P2-P2)/(t2-t1)
P: Parameter expressed in a user defined unit
t: Time (hour, minute or second)
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The way the ROC is set up and viewed is very similar to the TSD.
Under ‘Settings\ROC’ the ROC options can be set:

Rate Of Change Data Settings lﬂj

v Make ROC file when converting DAD->DAT

Time Unit Selection
" hour

& minute
(" sec

" no unit (constant = 1)

¥ Units are expressed with a prefix milli (E-3)

Cancel |

Figure 8.10 ROC Definition

The ROC is only computed when a DAD->DAT conversion is performed, and when
the user wishes. The time units are selectable as hour, minute or seconds. For small
changes it can be convenient to express the ROC as a milli (107) unit. For example if
the depth is in meters (m) then millimeters are expressed as (mm).

The ROC can be viewed as a trend under ‘View\Data Trend and Table\Rate Of
Change (ROC)’ or as tabulated data via ‘View\Measurement Data\Rate Of Change’'.

8.10 Chart

Title

Click on the title name to change the title of the chart. A dialog box appears:

r ™
Chart Title s

Enter New Chart Title:

[

I OK I Cancel |

L

Figure 8.11 Chart Title Dialog Box
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The chart is automatically assigned the data file number as a chart title. To change the
chart title, enter a new text string and press the OK button.

Time axis

To change the time scale of the chart, click on the X-axis scale. A dialog box appears,
figure 8.12.

By disabling the Automatic option, the minimum and maximum time values become
active. By clicking on the Change buttons for the maximum and minimum values, the
time range can be specified. For creating (saving) a new data file (DAT) with a new
specified time scale, please refer to chapter 10.Reconvert Data. By enabling the
Automatic option, the measurement time will go back to the initial range.

r N
) Axis Settings l = =] ‘&I

L (M e asuement time: 13.4.2003 - 3.12.2004

Scales
v Automatic

7 Aut

[V Aute 1ange M I 13.4.2003 00:00:01

3.12.2004 10:40:00

oK Cancel

Figure 8.12 X-Axis Settings Dialog Box

©2014 Star-Oddi. All Rights Reserved Page 54



User Manual SeaStar graphic Supporting Software

Value Axis

To change the scale settings for the value axis, click on one of the Y-axis scale. A
dialog box appears:

_
() Axis Settings | = | B |z

Scales
v Automatic

vV A '>‘2?,?38
vV A 1af ‘2,402

oK Cancel

Figure 8.13 Y-Axis Settings Dialog Box

By disabling the Automatic option, the minimum and maximum measurement values
become active. By clicking on the Change buttons for the maximum and minimum
values, the range to be shown on the chart can be specified. By enabling the
Automatic option, the measurements will go back to the initial range.

8.11 Chart Editor

The Chart Edit button (on every graph) gives access to the Chart Editor, a multi-
option menu, now with a Tree View interface, as can be seen in figure 8.14.

There are five main branches on the tree:

Series
Chart
Data
Tools
Export

The tree menu gives access to the same features as the tab menu described in the
user’s manual. Most of the changes invoked are viewable immediately.
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All format and style changes made to the chart, are lost if the data are viewed again or
“Reconverted”, as the *.DAD and the *.DAT file are not affected by changes made to

the chart or the database.

Series

The Series window offers the same features as the “Active Series List” button.

% | Edit chart

Temperature(*C)
Pressure{Bar)
Tilk-%(=)
Tilk-(=)
Tilk-2(=)
Comp.Head(*)
Comp. 4p(°)
Inclination(™)
TimeLine
—I- Chart
+- Axis
+- Titles

Legend

Fanel

Paging

Ey

k@ W — Temperature(™C)
tf-‘a W — Pressure(Bar)

Close

Add...
Az ¥ — Tien()

b ¥ — Tik-v( 4
Az W — Tik-z(e)

t@ 2 Cornp . Head()

w v Camp.4p(=) 4
k@ P Irclination(®) 4
w v TimeLine

Figure 8.14 Chart Editor

When a particular series is selected, like the Temperature series for example, a two
tab menu is revealed, as seen in fig. 8.15, where the user can “format” each series,
and set “points” in the graph. The tab “Point” offers visibility to points as the “Data
Point Marker” button on the graph, plus formatting of the points.

—|- Series

Temperature®C)
PressureBar)
Tilk-0=)
Tilk-(=)
Tilk-2(=)
Comp. Head(#)
Comp.4p(=)
Inclination(=)
TimeLine
—|- Chart

+- Axis

+- Titles
Legend
Fanel
Paging

Temperature*C) - w Line: Temperatured)

Format l Paint ]

Line Mode:

Border.,, —
[ Stairs

[~ Dark 3D

Color, | [ Color Each

Pl
i

Pattern. .. [v Clickable outline. .
Height 30: [0 ill [v Color Each line
Stack:  MNaone - Shadaow, ..
Treat nulls:  Donk Paint - Gradient.. [ |

Close

Figure 8.15 Format Series
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Chart

The chart branch has six sub branches:

AXis
Titles
Legend
Panel
Paging
Wallls

Axis

There are 8 axes in a normal SeaStar chart, the number in use depends on the
recorder type. The Left Axis and Custom 1 axis are always in use, the latter is reserved
for the timeline.

Tilk-2(*) Scales |Tite | Labels | Ticks | Grid | Pasition |

Comp. Head(#) .
Comp.4p(?) Optians ] Minimum ] Maximum ] Increment ]
Inclinationi*) ¥ Automatic
TimeLine
2 Chart [v Wisible [ Inverted

= Axis

Left Axis
Right Axis
Top Aaxis Log Base: r
Battam Axis
Depth Right
Depth Top
Custom O
Cuskam 1
Custom 2

[~ Logarithrmic

Close

Figure 8.16 Axis Formatting

Figure 8.16 shows a six tab Axis menu. There are numerous options, some of which
can drastically change the behavior of the graph. The Minimum and Maximum tabs
give options similar to the menu offered when clicking an axis on the graph, the ticks
tab gives access to enable and disable gridlines, just as in the “Horizontal gridline”
and “Vertical gridline” buttons in the graph.
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Titles

The Titles menu shown in figure 8.17, gives access to 4 tiles, each title a multi line text
window, which can be positioned anywhere on the chart. There are multiple formatting

options, six tabs, for each title.

Right Axis ~
Top Axis

Bokkom Axis

Depth Right
Depth Top v Wisible
Cuskarn 0
Custamn 1

Title

Texk:

v adjust Frame

Shyle ]Positic\n ] Format ] Border ] Text ] Gradient ] Shadow ] Pickure ]

Cenkter -

.
Legend
Panel
Paging

+- Walls

Daka

Custom 2 FIO119DAT

+- Tools _
Expork 3 Edit...

Close

Figure 8.17 Titles Menu

Legend

The legend menu (see figure 8.18) gives the user an option of showing a series

legend.

The 8 tab menu gives options in styling positioning and formatting the legend.

Top Axis
Eokbomn &xis
Depth Right

Cuskom 0

Cuskom 2

Panel
FPaging
+-Walls
Data
+ Tools
Export

Right Azis Skyle lPositiDn ] Symbols ] Title ] Format ] Border ] Text ] Gradient ] i s

[ wisible
Depth Top [ Inverted

Cuskom 1 [ Fonk Series Color

+- Titles Mo check boxes

-

-

Yert, Spacing: |0 i

Close

Figure 8.18 Legend Menu
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Panel
The Panel menu (see figure 8.19) offers panel format options. Images, pictures and
icons can be imported onto the panel as a back image.

Right Axis Calar ]Borders ] Margins ] Gradient ] Shadow ] Image ]
Top &xis
Eoktom Axis Color...[]
Depth Right
Depth Top [ Default
Cuskarn O
Cuskomn 1
Cuskam 2 v Back Image Inside
+- Titles
Legend
Panel
Paging
+- wialls
Crakta
+- Tools
Export <
Figure 8.19 Panel Menu
Paging

With the Paging menu, shown in figure 8.20, the data series can be chopped into
pages, with a user defined number of points per page. Only one page is shown at a
time, and the user can scroll through the pages via the page buttons, that appear (are
enabled) on the chart to the right of the Edit Chart button, when paging is selected.
Paging can be useful for viewing distinct time periods, one at a time, days or hours for
example. No offset is offered and sampling periods and start time can limit the
usefulness of this option.

s Edit chart ]
Right &xis A
Top Axis Poinkts per Page: |0 ill [
Bottan Axis
Depth Right
Depth Top [w Scale Last Page

Cuskom O
custom 1 [ Show Page Mumber Edit...

Cuskom 2 [ Auto scale axis
+- Titles
Legend
Panel
+- Walls
Diata
+|- Tools
Export

[w Current page Legend

Page 1 of 1

Close

Figure 8.20 Paging Menu
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Walls

Right Axis - f ="
Top s Iv Wisible \walls Size: [0 =i
Boktam Axis ’
Depth Right Left ]R|ght ] Eottom l Back. ]
Depth Top Color,,. ]| [ visible
Custom 0
Custom 1 Border... —| @
Cuskam 2
+- Titles Pattern... [ Auto Hide
Legend
Panel Gradient... ] [ Transparent
Paging
23R/l Position: siger o =
Dita Start: [0 j - =
+- Toals o T e =
Export - end: oo — ransparency: =i

Figure 8.21 Walls Menu

The walls menu, as seen in figure 8.21, gives access to configuration of four walls, but
as SeaStar charts are default defined as 2D, only the “Back” wall is visible.

The Walls menu, has similar options as the Panel menu, when defining a pattern, via
the “Pattern...” button, as seen in figure 8.21, an image can be imported and placed
on the wall. In fact, as the Back Wall lies “on top” off the panel, a pattern or an image
can enhance an image on the panel, or the image on the panel can be seen through
the wall with the Transparency option.

Data

In the data menu, seen in Figure 8.22, gives the user access to the database, upon
which the chart rests. Here text labels can be set to each measurement point.
Changes can be made to the time and measurement values. Changes made to the
data, are included when the data is exported, but if the data are viewed again or
“Reconverted” all changes are lost, as the *.DAD and the *.DAT file are not affected by
changes made to the database.
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% | Edit chart

Right Axis
Top Axis
Bottom Axis
Depth Right
Depth Top
Custam 0
Custam 1
Custor 2
+- Titles
Legend
Panel
Paging
+- Walls
+- Tools
Export

Y

X

— Temperak
X

—Pressurel
i “

24,526 108 170700

183,09 108 17:07:00

—Tilk-x(ey
¥ L=

ng 17:07:03
08 17:07:06
NG 17:07:09
wng17:.07:12
& 17:07:15
ng17:07:18
wns 170721
M0E 17:07:24
ng 17:07:27

na 17:n7:3n ¥
>

AM o xB

Close

Tools

Figure 8.22 Data Menu

Under 'Tools' you will find several options to customize the setting of the cursor and
the appearance of the graph, such as page numbering, font, font size etc. To
active/deactivate the chosen setting check/uncheck the 'Active’ box on top of the first

page of this menu.

i | Edit chart

Right Axis
Top Axis
Bottom Axis
Depth Right
Depth Top
Custarm 0
Custarm 1
Custam 2
+- Titles
Legend
Parel
Paging
+- Walls
Daka
:

E:xpiork

L

add...

Cursar

Page Mumber
Ap- Rectangles
Mark Tips

Pen...

Style:

Werkical

Horiz, Size:

o

Scope Size:

. =l

‘ Delete ‘ [v Active

Seties:

TimeLine

Style ]Snap | mouse |

-

Vert. Size:
=

S

Scope style:

[ et oY

3
:

Close

Figure 8.23 First Page of Tools Menu
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Export
Under the Export menu, three tabs offer as many menus for saving data as:

Pictures
Native (data)
Data (file)

Right: &xis Picture ]Native ] Data ]
Top Axis T ’
Boktaorn Axis o MobaFil Options ISIZB l
. a5 Metafile
Depth Right as Bitmap
Depth Top as JPEG v Enhanced
Cuskom 0 as GIF
Cuskom 1 as POF
Hstam a5 WML (HTM)
Cuskom 2 a5 SYG
+- Titles
Legend
Panel
Paging
+-Walls
Data
+]- Toals
Copy ‘ Save, ., ‘ Send. .. ‘
v

Figure 8.24 Export Menu: Picture

Pictures
Figure 8.24 shows options when saving the chart as a picture to a file, or copy the
picture to the clipboard. There are seven format possibilities.

Metafile
Bitmap
JPEG
GIF
PDF
VML
SVG
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Native

The Native menu, see figure 8.25, data is saved as “Native” *.tee chart files. Import of
these files is not supported in SeaStar at the moment.

Right Axis
Top Axis
Botkorn Axis
Depth Right
Depth Top
Custorn O
Custorn 1
Custom 2
+|- Titles
Legend
Panel
Paging
+- 'alls
Data
+]- Tools

Picture  Mative |pata |

[v Include Series data

Format:
(* Binary

" Text
" mML

[ |

[ File size: 7

| Save... ‘ Send... ‘

Close

Data

Figure 8.25 Export menu: Native

Data can be exported to files in four formats, see figure 8.26.

Text file (.txt)
XML (.xml)
HTML (.hml)
Excel (.xIs)

Right Axis
Top Axis
Boktom Axis
Depth Right
Depth Top
Cuskam O
Cuskarm 1
Cuskam 2
+I- Titles
Legend
Fanel
Paging
+- Walls
Daka
+- Tools

Picture ] Mative [ata
Series: Inchude:
all - [~ Point Index
v Point Labels
Format: ¥ Header
9 Tk [~ Point Colars
7 =ML
" HTML Table Deelimiter:
" Excel Tab hd I_
Text Quotes: I_
Copy | Save,.. | Send. .. ‘

Close

Figure 8.26 Export menu: Data
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There are four Include options:

1. Point Index
The point index is the same as the measurement number, but offset by -1, as it
starts in O instead of 1.

2. Point Labels
If the user has added text labels to points in the DATA menu, these can be
included.

3. Header
The same headers as are in the DATA menu.

4. Point Colors
This option is not relevant in SeaStar.

Another method for exporting is to use the Alt+PrintScreen keyboard buttons to copy
an image of the SeaStar window to the clipboard, thereafter to paste it to another
Windows application. When a dialog box is open, then only that frame is copied to the
clipboard.

To copy a part of a data file, for example from a DAT file, then highlight the part you
want to copy and use the Ctrl+C keyboard buttons to copy the data snippet to the
clipboard. Then use the paste-option in another Windows application to transfer the
data from the clipboard.

Figure 8.27 Highlighted Text to be copied
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8.12 Timeline

The timeline is a graphical viewing aide. Every time a file is loaded for trending, an
extra time value is calculated for every measurement point. These time values form the
Timeline. The Timeline is an extra series that follows the rules of the other
measurement series. When the graph first appears, the Timeline is inactive.

By selecting the Timeline in the Series List (see fig. 8.28), the Timeline becomes
visible as shown in figure 8.29.

Series List g@@

wW— Pressure(Bar) &
@ W — Tilt() -
%@ v — Titv -
}:@ W — TitZ[

i@ v Comp.Head(’]

%@ ™ Cormp.4p(°]

%@ W — Inclination(*)
%@ [~ — TimeLine

Figure 8.28 Timeline Selection

RIETE =i glosed L3

Vo whey e 13 008 < 20,5001

B o e C
M 2061 w292 2008 0008 .0 T O A 156 - - - »

[

Figure 8.29 Timeline onMaI é}aph showing “Day of the Year”
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The Timeline is defined under Settings\Preferences\Timeline.
There are several options for the Timeline, as can be seen in fig. 8.30.

r ™y
Timeline Definition &J

Define Timeline

* Day of the Year (1-365)
" Month of the year (1-12)
T Week of the year (1-52)
" Day of the month (1-31)
" Hours of the Day (0-23)

Cancel I

Figure 8.30 Timeline Options

There is no need to reconvert the data, as every time a data file is loaded, the Timeline
is calculated in accordance with Timeline settings. The Timeline is not a part of the
*:DAT or the *TSD files, but if the data is exported (see the Export section), then the
Timeline, if selected, will be included. Thus, the Timeline can also be used for
statistical purposes.

8.13 Templates
There are two scenarios where templates come in handy:

1. When many recorders are programmed with the same settings (multi mode),
and circumstances are in a way that the user cannot complete the setup of all
the recorders in one session, and he has to exit SeaStar (to continue later).

2. When the user wants to reuse, partly or completely, presumably a complex
and/or lengthy measurement setting.
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Saving a Template

The user can now, when editing New Measurement Settings (NMS), save his work by
enabling “Save this NMS as a Template (file)” option (see fig. 8.31), before
acknowledging OK from the Edit NMS menu. Having selected this option and the
NMS are OK, and then the user has an option to write a description for the template
(see fig. 8.33). Canceling this option cancels the ‘save template’ operation. The
template is an INI file and saved in the SeaStar\NMS directory. The name of the file is
MST<date><type letter>time<Interval mode>.INI.

() Set New Measurement Sequence | =R —&‘

Set start time:

2 v
Start date: 9.11.2010
2 A] -
Start time: Hour 13 v| Min 0 hd

Set measurement interval time

Hours 0 :
Minutes IO :]
10 =

Seconds

Primary / secondary - definition-
(& TD-CompTilt normal

(" TD as primary

" CompTilt as primary

Secondary counter: 0 -

v

Values allowed are 0,2,3,4,5..255

e | e
& Single mode

Use Default
" Multi mode

[~ Save this NMS definition as a Template (file]

oK | ancel |

Figure 8.31 Template Options in Edit\New Measurement Sequence
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Save NMS as Template

Template Name: MST9112010J142916S|

Template Description: |

Cancel I

Figure 8.32 Saving NMS as a Template

Using a Template

Templates can be retrieved at a later time to be used directly or modified. The list of

templates is kept in the SeaStar\templets.ini file.

As can be seen in fig. 8.31 there are three buttons in the Edit NMS window, the top

button is used for retrieving a template.

As can be seen in fig. 8.33, templates are selected via template name or description.
Parallel to selecting a template, descriptions can be edited and eventually templates

deleted.

The recorder type and interval type, which the template was based on, are visible for

each template.

L Select Tempinte

Terrglate bt

Tercie nave (AR N ~ |

11 No descriptir

Edv deorphor

Deszaglen

Dmhnbe tmerghet

x Canosl

Intaval Type Provey Rectede Type

Figure 8.33 Template Selection

Templates can be used across recorder type boundaries and interval types.
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Things to keep in mind when selecting a template are:

e Single interval templates converted to a multiple interval NMS. All seven
intervals are the same.

e Multiple interval templates converted to a single interval NMS, set the interval
as interval one.

e Start time in the past is not allowed as will be apparent when exiting the Edit
NMS window.

e Some recorder types are less compatible than others, an example of that is a
DST milli template converted to a DST GPS NMS.

After selecting a template the user is returned to the edit window. If the selection is
not as what the user expected the “Previous” button will return the previous setting.

The user has one more option to quickly set up the NMS. The button in fig. 1, marked
“Use Default”, will return default NMS settings. The button can have four descriptions
and return four different settings depending on the status of recorder and
measurement selection.

Use Default: No recorder selected.

Use Recorder: Recorder selected but not a measurement sequence.
Use Sequence: Measurement sequence selected.

Use Online: Recorder is on-line.

PONBE
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9. Multiple Intervals

SeaStar has the option for setting up more than one sampling interval within a
measurement sequence. Reasons for wanting multiple intervals can be to save
memory, but still be able to have frequent measurements in between. This may be the
case with fish tagging, when frequent recording is wanted in a specific period in the
fish life cycle. If you want to run on a single interval the whole recording period, this
option is not selected.

Select Multiple recording intervals in the wizard or choose the Edit menu and the
New Measurement Sequence Definition command. Select Multiple Intervals and
the following dialog box appears:

& Set New Memsurerent Sequence &]
Stat bve Mode A
— . pe Tomplate rderydl sogumnce
AENESON 9.11 2000 -J’ * Segle mode 1 11 al
Upe Defak
— o — r -
Start fmec Hour 14 :5 vn P32 3 Mk mode 22 |2
Pravo.s
3 {: -
Meauaoment Inberval poes I |
4 4 2
Seconday -
Type e Housz MNirssder Seconds Nurber of mwat Pronay /Seconday Courds 5 f( ~
1 'rl =80 :}' THlE 600 2] 110 Conpla nomal | o 4 [ =
=
2 ’ru 2 HE N E 1200 2] |T0-CompTit nomal < o 4 6 =
“ " = . v — v e}
o ‘! 2
3 'l'l atlo 2t h = 1800 = T0-CompTit nomnal «| o = 7 =
0 S0 15 = ) & hd = ‘
= T i - TO-CornTR o | | 8 !'. =
4 [u a0 An i {2400 = 0-CompTit nomal “| o |4
v v Y . - o - — vl r
5 [Iil 20 31 (3] Booo 3] |To-ComeTtnoma |l o |4 8P =
vl | vl - : v - ol
=
6 ’[l 20 2N 2 13600 2| |TO-CompTitnomal vl fo 4 10 >
5 5| . v -l
‘ - 1M 2
7 24 2o 2o = 700 = T0-CompTit nomal | lo 4l ! o
[s4 5] |0 v | = 1 = - K ol :
1210 o
137 2
™ Save tuor NNS cefindion a0 a Tenplate (fle)
187 2
O I | Cancel l

Figure 9.1 Set New Measurement Sequence (with multiple intervals)

9.1 Start Time

The user defines the date and time when recordings should start.

9.2 Measurement Interval

The sampling interval (time between measurements) is defined. Any value from 1 to 99
seconds, or 1 minute to 24 hours with increments of 1 minute. Up to 7 different
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sampling intervals can be selected. If seconds are used as sampling interval, the
multiple of the sampling interval and the number of measurements must be dividable
by 60.

9.3 Number of Measurements N1-N7

The user defines the number of measurements to be recorded within each sampling
interval. A value from 1 to 60000 must be set. Please note that an inital measurement
is taken at the defined ‘start time'. This initial recording is not counted as a
measurement for the ‘Interval 1’ number of measurments. For example if the recorder
should measure every hour from midnight to ten o’clock (00:00 — 10:00), then the
number of measurements defined should be 10. Please note that only this one
measurement at the ‘start time’ does not count as a measurement for the intervals. In
this case, the first measurement counted for the ‘Interval 1’ is at 01:00, and the last
measurement is at 10:00, and then it shifts to another interval.

After taking one measurement at the ‘start time’, the recorder will start on the first
interval in the sequence and take the number of measurements as defined. After
taking the measurements on the first interval, it will automatically shift to the next
interval etc. The sampling intervals and number of measurements will recycle until
memory is full, or until connection is made with the recorder through a PC computer.

9.4 Sequence 1-14

The interval sequence must be filled out. As shown in figure 10.1, the user selects to
use intervals 1-6 for the recordings. Another example:

If two of the first sampling intervals are used, the sequence should be 1, 2, 1, 2 etc,,
meaning that the recordings shift between the first and the second intervals, recording
the defined number of measurement for the first interval, and then shifting to the
second interval taking the number of measurements defined. The shifting between the
intervals repeats until memory is full, or until connection is made through a PC
computer.

9.5 Primary/Secondary

With default setting, both Temperature-Depth (TD) and CompTilt is recorded at each
sampling interval (TD-CompTilt normal). The user has the option to select either TD or
CompTilt as a primary sensor for each sampling interval. The objective with this
feature is to save memory size, increase recording period, and get more data on the
sensor that is of more interest (primary sensor).

The secondary counter is only meaningful if a primary parameter has been selected.
The secondary counter defines how frequently the secondary parameter is saved
along with the primary parameter. If for example Comp-tilt is selected as a primary
sensor, and the number 3 is defined as a secondary counter, the TD will only be
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recorded every third time when CompTilt is recorded. If the value is O (zero), the
recorder is in principle a Comp-tilt only, except the first measurement is always a TD-
CompTilt measurement.

There are restrictions on the secondary counter settings when multiple intervals are
defined. If a primary parameter is selected and secondary counter is O then the
‘Number of meas.” for the primary counter must be an even number. If a primary
parameter is selected then the ‘Number of meas.” must be dividable by the secondary
counter, and only odd numbers (0,3,5,7...255) can be used as a secondary counter.

The Use Template can be used if older definitions have been saved by enabling the
‘Save this NMS as a template (file)’. That way it's possible to get templates that have
been set up in the past. With the Use Sequence button it is possible to get same
settings as from other recorders, by browsing for their serial no. By hitting the
Previous button the settings go back to previous, before changes were made.
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10. Reconvert Data

In SeaStar you have the option of reconverting data that has already been retrieved.
After re-defining parameters, the data is reconverted by ‘File — Reconvert Data’. The
main reasons for reconverting data are:

e Adjust the center point for the pitch and roll measurements.

e Shift pressure/depth values according to a reference meter, to increase
accuracy.

Adjust measurements that are outside calibration range.
Incorrect PC-time at measurement start time.

Need for temperature or pressure/depth unit alteration.
Need for data file format alteration.

10.1 Data Reconvert Definition

Under the Edit menu and Reconvert Definition, choose the Data Definition
command, and the following dialog box appears:

- Tge—
L Data Recoevewrt Definition | vim Q
S mconsEon TeaswTeed Segencs Hat-e Torw bt aduitrverd
126. 7 2012 ol F NoLnea Tine Adustrect
! dad v~ e =

Linear adpsstment tree jrand

[ar] o]

Tiews span Jayt] |

-l &
St HoafS 5| Mnl? 5
MDo | Previons
I ASCOTAst LN Loe masasrrerd rdervalk Yom In ecorversun (e otrodads o
& NID fi=
¥ Irberval defedion i NID 4 lldic
Canant nem messurenand seguencs delindon RO e
~ RBD fiw
Convet runder of dats sccondeg o Dt O Harge Decand Values Selbnge

& Al e dota n the DAD §in o Full 1oade (No boundases|
ol 4 0 b 3

Uses defned munter of dala

From messurarent rurber | ™ Usas cefinion

To meatirennnt mabe

Temng cooettion outude larg Calbiaton Asnge
O Nomeal conecnon
& Last conecson W Diable trradlavgs bevord conneclon Sre

7 No conection

Caneent :

X Cancel

Figure 10.1 Reconvert Data Definition
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Set Reconversion Measurement Sequence Start-Time

If the user notes from retrieved data that the PC date and clock were incorrect when
measurements were started, it is possible here to specify a new start date and start
time.

In Reconversion use Measurement Intervals from

The measurement interval is either the interval settings as shown in the measurement
(MID) file, or if that interval is incorrect, a new and correct sampling interval is
specified in the ‘New Measurement Sequence Definition’ command in the ‘Edit’ menu.

In Reconversion use Constants from
The user can choose to use calibration constants from:

e MID file. This option should normally be selected, as it contains information on
the constants from the measurement sequence.

e RID file. The recorder information file contains the same calibration constants
as the MID file, except if it has been re-calibrated. If it has been re-calibrated,
and the user wants to use the new constants on older measurements, the RID
option should be selected.

e RBD file. This option rarely needs to be selected. If the constants from the MID
and RID file are corrupt, the user should contact Star-Oddi for an RBD file.
See chapter A.3 for instructions on how to transmit the RBD files to the
recorder.

Convert Number of Data

The user can reconvert all the data in the last measurement sequence, or define the
number of measurements to be reconverted. The user has the option to define what
measurement range should be reconverted (for example to exclude data points when
the recorder was above water).

Time Linear Adjustment

The real time clock inside the DST has an accuracy of approximately +/- 1 minute per
month. This slight variation might accumulate over time and influence the
measurement results. To correct the gradual time shift first check ,linear adjustment
time“ then type in the time offset value and the length of the measuring period.
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Out of Range Decimal Value Settings

Measurements that are outside the calibration range are inaccurate, and may give
erroneous results. The out of range (OOR) measurements can be seen in the OOR
file. The user has the following decimal value out of range detection options when
reconverting:
¢ Full scale (no boundaries). This means that literally no ‘out of range’ detection
will be made.
e User definition. With this selection the range definition under ‘Settings - Out
Of Range - DV definition’ will be used. This option is selected when the
decimal values (DV) are not available in the RID file. This would normally
require the user to contact Star-Oddi for the decimal values.
e RID values. The calibration decimal range is given in the RID file. This is the
default option and should normally be selected.

If an RBD file exists in the \Seastar\RBD folder, then SeaStar recognizes this file as a
primary source for DV calibration range. In this case, the fourth option appears and is
set as default.

Temp. correction outside temp. calibration range

The user can choose to apply temperature correction for measurements that are
outside the temperature calibration range.

Normal correction: Measurements are always temperature corrected
Limit correction: Temperature correction is limited to calibration range
No correction: Temperature correction is not applied.
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10.2 Temperature Definition

Under the Edit menu and Reconvert Definition, choose the Temperature Definition
command, and the following dialog box appears:

.} Temperature Reconvertion Definition [ H =] ]
Temperature offset adjustment
¢ No offset adjustment

" Difset adjustment value [m'C] |0 =

-

Single spike corection

Ti l -
[T Use single spike comection me |0 see
[~ Slope corection Limit ]U

; - Shift in
Start Point Iﬁ seconds
EndPoint |1 2 Jo 3

Linear estimation outside calibration range
[ Use linear estimation outside calibration
[~ Use at next data retrieval for this recorder

Note: This overrides 00R correction definition

oK I Cancel |

Figure 10.2 Temperature Reconvertion Definition

Offset Adjustment

When recorders are used over a long period of time, the temperature measurements
can start to deviate from correct values.

When checking older recorders, it has come apparent that the error in the
measurements is mainly due to an offset. Some users feel they can benefit from an
offset correction option in SeaStar, for example when a recorder has been in the water
for a long time and is later tested to show an offset. The offset is defined in m°C
(1000 m°C = 1°C).

Single spike correction
Check Use Single Spike Correction. There are two variables, Time and Limit. The
Limit defines how much difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is then
calculated as the average of the adjacent points.
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Temperature response shift

It is possible to set the desired start/end point to be shifted by X seconds. This shift
can only be performed on data with an interval of 1 second.

Linear estimation outside calibration range
Check this option to linearly estimate temperature measurements outside of

calibration range.

10.3 Pressure Definition

Under the Edit menu and Reconvert Definition, choose the Pressure Definition
command, and the following dialog box appears:

L Pressure Recomvert Definition [ =]
[T Dizable terrperature conachion o prosune caloulahoen
Preaswe oflset adpatmont Fressue knox adustnent
(" No cifset adusimert v Nolnex adustment
(¢ Dftset achastment vahee [nllaR] |0 = 7 Unesr adustmery, vaus [mBOR) <!
s Time span [days] [ =
& Subliact the vabae il i
 Addthe v
Oihe yole Nogative dope carechon
% Pomtve Hope coreclion
[T Use =t nest data retseval for fhe iscorder
Linoas estmanon cutide cakteahon lnge
[T Use i astimanion outsade caltralion
[ Use o rest data retseval for thes recorder
Note: This ovessdes D0R conechon defirston
Soge ke conechon
= Time i :
[T Use sngle spe conachion u A
[~ Skpw conecton Untd W0
Freeze lemperatve covection m pressure slep
[ Use fwed temperatur conaction n precsus step
From T ii To ‘r‘,'{;ﬁ_? Terp ) i_-.
Padform faed tampetatae comecton ——
oK Cancel

Figure 10.3 Pressure Reconvertion Definition

Disable Temperature Correction in Pressure Calculation

In case the temperature sensor is malfunctioning in a way that it will indicate very high
temperature values, it will offset the pressure calculation. An automatic temperature
correction is set by default in SeaStar. To turn off this feature, check the box next to
,Disable temperature correction in pressure calculation®.
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Pressure Offset Adjustment

The user can increase accuracy of pressure/depth recordings by finding an offset
value, which is the difference between a recorder's depth value and a reference
meter’s value. Once the offset point has been set in, the data can be reconverted, and
all pressure/depth recordings shifted according to the value defined (in mbar).

In cases where a drift has occurred with the pressure recordings, the pressure data
can be corrected if the user has a known reference point for correcting the data. To
find the offset value, the recorder should be deployed in water, at a known depth
(preferably >2 m depth), or placed along with an accurate reference depth meter,
where a reference point can be taken. Once the offset value has been found, the
offset pressure value is put in the window shown above. The offset value can either be
subtracted or added to the pressure values.

When using 9.81 as g, the coefficient for converting cm into mbar is 1.019. For
example: 100 cm = 101.9 mbar. If the ‘Use at next data retrieval for this recorder’ is
enabled, the offset value is fixed for that particular recorder, and future data uploads of
the recorder will use the offset value defined, for shifting the pressure data. The offset
value will apply only to that particular recorder, and other offset values can be defined
for other recorders.

Pressure Linear Adjustment

Aging of the pressure sensor can result in an offset of the measured pressure values.
To correct these offset values you can select a linear pressure adjustment. Check
Jlinear adjustment value“ and fill in the pressure offset value (difference between
expected value and real value at the end of the recording period) and the length of the
measuring period.

Linear Estimation Outside Calibration Range

The pressure sensor tolerates a significantly higher pressure than its calibration range.
If the recorder is exposed to higher pressures than its calibration limit it will result in
erroneous data. By choosing this option you will receive more adjusted values. Please
note that since these values are outside of the calibration range an exact adjustment is
not possible, this feature is mainly for estimation purposes.

Single spike correction
Check Use Single Spike Correction. There are two variables, Time and Limit. The
Limit defines how much difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is then
calculated as the average of the adjacent points.
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Step Correction

The Step Correction option is mainly intended for those users who are doing research
on fishing gear such as long lines and trawl doors, although it might benefit other
users as well.

When the recorder has been on deck for a long time there is a significant temperature
change when it hits the water and as a result the normal temperature corrector might
not function correctly In order to avoid inaccurate measurements, the user has the
option of using a fixed value in the temperature correction.

In the From field (see figure 10.3) enter the number of the measurement when the
sensor hit the water and in the To field enter the number of the measurement when
the temperature became stabilized. The temperature value of the latter measurement is
entered in the Temp field. This fixed value is then used to correct the pressure value.
The graph in figure 10.4 displays the difference between normal correction (red line)
and step correction (blue line).

* Patters Pimder v, 004 - OG1 1C P atverd inter | 36D roges & W TG TOL | AT - [Dweriey Owrt 30 P attared bvder 1 BN I ropec tyWE RG NOG MDY 00004

L

Figure 10.4 Normal vs. Step Correction
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10.4 Tilt Reconvert Definition

Under the Edit menu and Reconvert Definition, choose the Tilt Reconvert Definition
command and a dialog box appears (see figure 10.5).

Tilt Reconvert Definition

Single spike correction

Angle offset adjustment
[~ No angle offset adjustment [~ Use at next data retrieval for this recorder
Pitch-angle Roll-angle Z-angle
Offset adjustment (m®) |0 _;j Offset adjustment (m®) |0 | % Offset adjustment (m®) |0 =
+ Add &+ Add + Add
" Subtract (" Subtract " Subtract
New Tilt Range Values
[~ No New Range |~ Use at next data retrieval for this recorder
MIN MAX
| E—
X:(1-32767) |15226 _:_] I23171 = l Calibration values from recorder I
Y: (1-32767) |16153 2} ]24022 i} ‘ Last defined values I
z {
Z: (1-32767) |l°489 .EJ 124114 _:J ‘ Use Last Conversion Statistic values I

[V Use 90° sum correction

oK | Cancel |

Figure 10.5 Pitch & Roll Reconvert Definition

Single spike correction
Single spike correction works with nocks and bumps, sudden spikes that can clog up
the picture, also “large” jumps over the 180° boundary line.

Check Use Single Spike Correction. There are two variables, Time and Limit. The
Limit defines how much difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is then
calculated as the average of the adjacent points.

Angle Offset Adjustment

As the ‘No angle offset adjustment’ is disabled the above box appears. The X, Y and Z
angles can be adjusted. The offset value can either be added or subtracted.

New Tilt Range Values

Normally the ‘No new range’ is enabled and not configured by the user unless with
consultation from Star-Oddi. The purpose of this feature is to put in a new range when
recalibrating the X and Y axis of the compass.
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10.5 Compass Reconvert Definition

Compass Offset Adjustment

Under the Edit menu and Reconvert Definition, choose the Compass-U,V command
and a dialog box appears:

Commpass Reconvert Definition ‘-3
Snge sodee correchon Soundery Round OF
X Tee |
[T Use singhe spke comection e sac - =1 t0- 459
— v
[~ Sape comection Unt 45
¥ Lise Tit to corect Compass vakoes [T Use flast headng value if Pitch or Roll > 457
Use last heading velue 129 < Act < 0,89
Angle offset and Ongo adustnent
[ No Angle offset aciustment ™ No New Rangs
Compass Headng angle New Compass Range vValues
P ——— MIN MAX
Dfiset sdiustment (%) a __XAA — e
29 .l G
U: (132767 |1699¢ ¥ 19455 S
* A 1 .
" Subract v(eazen |88 3] =
1 re -
2M57) X i
[T Use at next data retreval for S recorder
Calbraton vakues from recorder |
Last cefrwd vahes I
Use Last Corversion Stadishic values l
[ Use st next dats retneval for e recordes
o Cancel \

Figure 10.6 Comp-tilt Reconvert Definition

Single spike correction

Check Use Single Spike Correction. There are two variables, Time and Limit. The
Limit defines how much difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is then
calculated as the average of the adjacent points.

Boundary Round Off

Boundary Round Off is aimed at minimizing shifts over the 0°/360°border, as the 0°
and 360° are the same point. Small changes in heading values around the 0°/360°
line are filtered out. The limit values are in 0-45°. The default value is 20° , i.e. values
within 20° and 240° give 0° or 360°, depending on previous value.

Compass Offset Adjustment

As the ‘No angle offset adjustment’ and ‘No new range’ is disabled the above box
appears. The Compass heading angle can be adjusted. The offset value can either be
added or subtracted. Although the DST magnetic is a two channel magnetic
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measurement device, the software converts the values into a single heading value. The
heading value shows the Magnetic North.

In order to change the heading value into True Geographic North it is necessary to put
in an offset adjustment for declination. The declination varies between regions but it is
possible to see the declination in each area on the internet. The declination value can
be found at www.ngdc.noaa.gov/geomagmodels/struts/calclGRFWMM.

It is recommended that the user makes reference measurements of the magnetic
heading prior to a study.

The performance of the DST magnetic is optimum when it is placed in the horizontal
plane, the further the comp-tilt pitches and/or rolls from the horizontal plane the larger
the error reading becomes. If it is shown that the recorder has not been mounted in a
0°C horizontal position it is possible to put in an approximate offset value based on
the tilting of the DST housing.

10.6 Magnetic field definition

Under the Edit menu and Reconvert Definition, choose the Magnetic field definition
command and a dialog box appears:

. Magnetic figd defnttion | [ = |t

Deployment and Retrieval Location
Deployment Retrievs
Dace s Mn Date: Hour A
2222008 <« [ P 5 (2222008 [0 5|0 2
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al | | I N
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[c3370 1A T al
Magrwtic Seld vector (n7): | 2379 vl Magnesc el vectar (AT} |7 9

" Lise Pogition %0 comect absolute magnetic fieid vecior FinT)
Magretic Sed

Use e New Nugnetic Feld Yecter Referarce (1) |52379
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|

L

Recorder value: 52379
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Figure 10.7 Deployment and Retrieval Locations

©2014 Star-Oddi. All Rights Reserved Page 82


http://www.ngdc.noaa.gov/geomagmodels/struts/calcIGRFWMM

User Manual SeaStar graphic Supporting Software

Magnetic field reference

The magnetic field unit values are derived from magnetic nominal values and the
magnetic field vector reference. The user can now change the reference value and use
in reconversion.

Magnetic temperature correction

DST magnetic recorders, serial number J0535 and higher, have magnetic temperature
correction calibration for all three axis. The calibration constants can be viewed in the
* RClI file, see figure 10.8.

® E:\MAG\T\JT\JO553.RCI

U-axis Tewperature Fegulation constants ~

Ttc.Cl @ 10,35947246423045

Ttc.CZ2 @ 0,0241383380533418

Tto.C3 @ -0,00364943429766357
Tteo.C4 @ 4,57947211479503E-5
Tto.Ch @ 2,42387128422401E-7
T-temperature referance [(°C): Z0.7

V-axis Temperature Fequlation constants
Wtc.Cl @ -22,9507264120796

Wto.C2 @ 0,2925454916025875

Wtc.C3 @ -0,0127216457049069

Wtc.C4 @ 0,0002708654545475863

Wto.Ch @ -1,9658758954521407E-8
V-temperature referance (°Cj: 19.2

WM-axiz Tewmperature Regulation constants
Wtc.Cl @ 2,59252472703239

Wtc.C& @ -0,32951793421956

Wtc.C3 ¢ 0,022318270183520L1

Wtc.C4 @ -0,000645102516137695

Wtc.Ch @ 6,51629310278731E-6
W-temperature referance [(°C): Z0.7

Mammetic reference (nT): 523789 i

Figure 10.8 RCl file

The temperature can be disabled in Edit-Reconvert definitions-Magnetic field
conversion, see figure 10.7.

Deployment and retrieval location

Before releasing the DST magnetic the user should note down the release time and
date, latitude and the magnetic field vector. These information should also be obtained
upon recapture of the DST magnetic. To correct/improve the tilt and magnetic field
calculations the user should enable that option and insert the information on time-
date, latitude, magnetic field vector, both for release and recapture of the recorder.
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Reconvert Data

After acknowledging the offset adjustments, the data need to be reconverted, for the
adjustments to be effective: <File\Reconvert Data>.

View Previous Conversions

Each time a reconversion is performed, a numbered file is created in the sequence
folder.To view previous conversions select a file under View and choose Previous as
can be seen in figure 10.9.

Recerder Cabbeapon Il mmation FCT)
Racorder Dowtined lrformeten (FOT)
Teut fows (TXTINCOAD CCTUMT, FPS NAT)

Meassegnod  PowOn (Comd

Figure 10.9 Previous Conversions

The window in figure 10.10 appears. Select a numbered file from the drop-down list.

-3C3621,DAT

I 1-3C3621.DAT |

Figure 10.10 Select Previous Conversions
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Reconvert Previously Retrieved Data

If data from the same sequence is retrieved more than once, a bookmarked data
sequence file (DAD) is created. These files can be accessed and reconverted by
choosing File-Reconvert data-Previous as can be seen in figure 10.11.

o -

Aatafies 16 reacabin tedt files |Meas.seq.ne: 3 PowOn Coml |

Figure 10.11 Reconvert Previously Retrieved Data
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11. Recorder Modes

In this chapter, the three operational modes of DST magnetic are described, that is
the PC Mode, Sleep Mode and Measurement Mode

11.1 PC Mode

If the recorder is in the correct position in the Communication Box, and by choosing
the Recorder menu and the Connect command, the recorder is put into PC Mode. At
the bottom of the SeaStar window, the text On-line is displayed, indicating that the
recorder is on-line and in PC Mode.

While in PC Mode, the recorder will remain in an active listening stage. The
communication protocol is a simple master/slave arrangement, in which the recorder
is the slave. The slave will perform every command the PC issues, and after execution
of a command, it will return to listening. When the recorder is connected to the PC, it
is powered by the PC, and not taking energy from the battery inside the recorder.

11.2 Sleep Mode

The user receives the recorder in Sleep Mode, but it can easily be awakened by the
Connect command in the Recorder menu. If the recorder is not set in Measurement
Mode, it goes into Sleep Mode when the recorder is removed from the
Communication Box. When the recorder is in this mode, less energy is depleted from
the battery.

11.3 Measurement Mode

The recorder is put into Measurement Mode by choosing the Recorder menu, and
Start New Measurements Sequence. The recorder starts recording measurements
according to the start time (date/month/year) and sampling interval (hours/min.)
defined by the user.

When the memory is full, the recorder shifts automatically into Sleep Mode. If the
recorder is still in Measurement Mode upon connection through a PC computer, it
stops recording and is put into PC Mode.
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12. Memory and Battery

12.1 Memory Organization

Data is kept in an EEPROM memory and will not be lost if the battery fails or expires.
The memory of the recorder is organized as shown in the figure below:

Data memory

- ——
< s

Settings —=

Unused memory/

ey resarelrgs Old recordings

Figure 12.1 Data Memory Organization

When data is retrieved from the recorder, the following occurs:
1. The computer retrieves the data from the recorder and writes the data to the
computer’s hard drive .
2. The recorder has stopped recording, but still holds the recorded data.
When new settings are sent to the recorder, the following will occur:
1. New settings are sent to the recorder.
2. The data memory pointer is reset to the beginning of the data memory and

starts to write over older recordings.

The organization of the memory is now as follows:

Data memory

'l

-
~

Settings —>

Unused memory/
Old recordings

Figure 12.2 Data Memory with New Settings
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12.2 Battery Calculations

The voltage characteristics of the batteries used in our recorders make it almost
impossible to measure the energy available in the batteries, therefore we estimate the
energy consumption by calculation. All the energy consuming functions of the
recorder, like sleep, decay, running (microprocessor awake), measurements and
saving data are measured beforehand and used in our calculations. The calculations
are performed by the application software’s, SeaStar, Mercury and FoodStar. The
recorders themselves do not perform any energy calculations, but in order to start the
recorder in one computer and retrieve data in another while still having the battery
energy information, they carry the percentage of remaining energy with them in a
register file (in the RID). At the time the recorder is in production (when the battery is
new) the energy number is set to 100%.

Each time the recorder is started up in a new measurement sequence, the energy
consumption, since last sequence-start, is calculated and subtracted from the energy
number retrieved from the recorder, and this new energy-left number is downloaded
into the recorder.

The energy-left register in the recorder can be corrupted for reasons such as:

e The CRC check is turned off when connecting to the recorder and a
communication error occurs

e When a write error occurs when starting up a new sequence or updating a
status to the recorder and a reconnection is performed instead of performing
the operation again.

e Energy estimation calculations are not in accordance with actual energy
consumption.

To change/correct the battery energy numbers in the recorder refer to chapter 13.5.
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13. Wizards

There are six wizards in SeaStar:

13.1 Connection Wizard

-
Connection Wizard

If using a communication box:
Connect the box to the computer and insert the DST
If using a StarCom cable:
Connect cable between the recorder and computer

Figure 13.1 Connection Wizard

Choose the Wizards menu and the Connection Wizard command to enter the
connection wizard (see figure 13.1).

13.2 Com Box Connection
Com Box é}
Connection

Check Yellow Light
Figure 13.2 Com Port Wizard
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Choose the Wizards menu and the Com Box Connection command to enter the
Com Port wizard (see figure 13.2). The wizard goes through available ports and
activates them one at a time and asks the user to confirm that the communication box

displays a yellow light (see figure 13.3).

Com Port Wizard I&J
COM1 &y
Did the yellow PC-com light tum on? "N
’ Yes | [ No l

Figure 13.3 Com Port Wizard

13.3 Start Recorder

Choose the Wizards menu and the Start Recorder command to enter the wizard

(see figure 13.4).
Start Recorder éf

Recorder Type

Connection

Define Measurement Sequence
Start Recorder

Figure 13.4 Start Recorder Wizard

This wizard starts the recorder with a new user defined measurement sequence.
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13.4 Retrieve and View Data

Choose the Wizards menu and the Retrieve Data command to enter the wizard (see

figure 13.5).
Retrieve Data é}

Recorder Type
Connection
Retrieve Data

Start Recorder

Figure 13.5 Retrieve Data Wizard

This wizard retrieves data from the recorder and offers the user to start it again with a
new measurement sequence.

13.5 Quick Retrieve and Restart Recorder

Choose the Wizards menu and the Quick Retrieve command to enter the wizard
(see figure 13.6).

Quick Retrieve and :
Restart Recorder
Connection
Retrieve Data
Define Measurement Sequence

Start Recorder

Figure 13.6 Quick Retrieve Wizard

This wizard retrieves data from the recorder without graphically displaying it and offers
the user to start it again with a new measurement sequence.
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13.6 Change Battery Life
A new wizard has been added to the Wizards menu, the Change battery life wizard.

Choose the Wizards menu and the Change battery life command to enter the
Change battery life wizard (see figure 13.7).

Change battery Iifeé}

Recorder Type

Insert Recorder

Connection

Set New Battery Life

Write Battery Life To Recorder

Repeat Wizard

Figure 13.7 Change battery life

Select the recorder type and insert the recorder in the Communication Box. Once a
connection has been established a window appears (see figure 13.8). If the recorder
is already on-line then the wizard will start in step 4 (Set New Battery Life).

L) Set Battery Life = ‘ﬂhﬂ

Total sleep-time (weeks) 59  battery used (%) 34

Recorder definition: Battery life left ( %) 64

(" Direct definition: Battery life left { %) 64 | %

v

(¢ Calculate from NMS, measurement weeks, and sleep time:
Calculate NMS Weeks measuring: 59 3
Estimated measurement battery usage pr, week (%) 0.77

Calculated total battery used { % ) 46
Calculated battery life left (%) 54

OK I Cancel l

Figure 13.8 Set Battery Life

The top line shows who long the recorder has been in use since (last) calibration, and
how much energy sleep and decay combined have used up over that time.

The second line shows Battery left based on the register in the recorder.
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There are two ways to set the battery life, Direct definition and Calculate from NMS.

Direct definition:

Check the Direct definition option and set the battery life (in %) manually based on
for example, the last known “good” value and an estimated/guessed value on energy
used since then. The user can also refer to other same type recorders working under
similar conditions.

Calculate from NMS:

Check the Calculate from NMS option and click on Calculate NMS. The user is now
transferred to the Set New Measurement Definition window where a sequence can
be defined. Once the measurement sequence has been defined an Estimated
measurement battery usage pr week (%) is calculated and shown in the Set New
battery Life window, note that sleep and decay energy use is included in this number.
Also the Calculated total battery used (%), which is based on the NMS definition
times number of weeks, plus the energy used by sleep and decay.

Now insert for how many weeks the recorder (since produced) has been measuring.
Each time the number of weeks is changed, the Calculated total battery used(%) is
recalculated, note that the Calculated total battery used(%) value will not show a
directly weeks * energy pr week, as the sleep + delay values must be accounted for.

©2014 Star-Oddi. All Rights Reserved Page 93



User Manual SeaStar graphic Supporting Software

14. Group

Creating a group is a way to gather multiple measurement sequences which are part
of the same research project into one group. In a group the user can track when the
logger was started, the data retrieved and the data converted/reconverted. Groups
can be transferred to PatternFinder for further data analysis

-

() SeaStar 5.65 - DST tilt - C:\SeaStar\DST tilt\

File Edit Recorder Settings View Wizards Window Help

Gr?m New Group t
14

% Open Group

Send Group To

Close Group

i:
Figure 14.1 Group menu

New Group
Select New Group to create a new group. Please note that it is also possible to

create a new group by clicking the New Group button E in the group view pane.
The following window appears:

) New Group M‘—&‘I

Name

Description

Figure 14.2 New Group

Name the group and enter a description. The group file will be saved under the
directory: C:\SeaStar\Groups. Each group has its own subfolder where data files from
each sequence in the group are stored, this way the data can be accessed from
PatternFinder and Gna.
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Open Group

Select Open Group to open the Group directory. It is also possible to open the

directory by clicking the Open Group button & in the group view pane.

Once a group has been selected the group view pane appears:

Group View

Qe ®

: Name: test®

----- _3 Description: test 1~

: Created: 2012.04.11 15:51:
Members

Figure 14.3 Group view

Adding sequences to group

To add a sequence to the group connect to a logger and define and start a new
measurement sequence. When starting the new sequence the following window
appears:

I} Add Sequence To Gro... l = ” (=] ”.‘lﬁl

Alias [test 1

Description | test groupl

OK Cancel

Figure 14.4 Add Sequence to Group
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Set an alias for the sequence and enter a description. Click OK and the sequence will
be added to the group (see figure 14.5).

Group View

e ®

ot Name: test

'8 Description: test 1-

e Created: 2012.04.0409:07: |

E-  Members

E) _3 test 1
Recorder: U5317
Sequence: 2

'3 Description: 10 min
Started: 2012.04.11
Retrieved: 2012.04.
DAB: OK
DAT: OK
MDD: OK

B 3 test 2
Recorder: U5317
Sequence: 3

.8 Description: 5 min
Started: 2012.04.11
Retrieved: 2012.04.
DAB: OK
DAT: OK
MDD: OK

Figure 14.5 Group view pane

If a group is open when starting up a logger the new measurement sequence will be
automatically registered in the group. If no group is open the sequence will not be
registered in any group.

Retrieving data

When retrieving data from a logger and the sequence is already in a group the data
retrieval time is registered in the group. Also when the data is converted/reconverted a
copy of the *DAT file is stored in the group folder.
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Send Group To
Select Send Group To to transfer a group to another software.

New Group
Open Group

Send Group To Send To PatternFinder

Close Group
Members

Send To Gna

Figure 14.6 Send Group

It is also possible to transfer a group by clicking the Send Group to button @ "in
the group view pane.

Close Group
Select Close Group to close an open group.
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Appendix

A.l Directories and Files

Directory Structure

The user can choose between SeaStar's default data directory structure (path) or
define his own data path. As the SeaStar program is a multi recorder type program,
the directory structure branches from the directory where SeaStar is positioned down
to type directories, i.e. Starmon mini, DST magnetic etc. From there it branches again
into recorder directories, named after the serial numbers of the recorders, designed to
hold data for each individual recorder (data directory). All in all it is a three level
directory structure.

An example of this directory structure with DST magnetic is:
C:\Seastarn\ The installation directory (SeaStar.exe location)

C:\Seastar\DST magnetic\ The type directory for DST magnetic
C:\Seastar\DST magnetic\l2018\ The directory for the 12018 recorder

When a new recorder type is selected in SeaStar (File — New Recorder Type), the
directory for that recorder type is created. When connecting to a recorder for the first
time, SeaStar creates the recorder directory, named after the serial number of the
recorder.

Information Files

SeaStar uses information files to store and retrieve settings. There are two types of
information files:
1) The type-INI files, (for example DSTq.ini for DST magnetic).
The information type files are all in the installation directory, they contain
information on specific settings for each type. The type-INI files are:

StarmonT.ini Starmon mini
DSTm.ini DST milli

DSTr.ini DST milli recycle
DSTu.ini DST micro
DSTc.ini DST centi/centi-ex
DSTs.ini DST CTD
DSTg.ini DST GPS
DSTx.ini DST pitch & roll
DSTq.ini DST compass
DSTi.ini DST comp-tilt
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2) The recorder-INI files, for example 12018.ini contains settings information and data
file positioning for the 12018 recorder. The recorder-INI files are located in the
appropriate type directory, i.e. all the Qnnnn.INI files are in the ‘DST magnetic’
directory.

Files Locations

As stated previously, the type-INI files are placed in the ‘Seastar’ directory, and the
recorder-INI files are placed in the recorder type directory. All other recorder and
measurement related files created by SeaStar, are placed in the appropriate
recorder’s directory. For example:

C:\SeaStar\DST magnetic\l2018\ is a directory for the 12018 recorder and all files
belonging to 12018 are placed there.

If the user whishes to use his own defined data path, for example C:\Data\, then all the
files for all the recorders, except for the INI files, are placed there. If the user has
enabled the “Create recorder directories” in the user path definition, individual
recorder directories, irrelative to type, are created under the user defined path, for
example: C:\DATA\I2018\ for the 12018 recorder. The 12018.ini file (located in the
C:\SeaStar\DST magnetic\) contains the path to the C:\Data\l2018\ directory, and all
files related to the 12018 will be placed in that particular directory.

Browsing for a Recorder

When browsing for a new recorder from the ‘Select recorder’ under the files menu,
the default method is to find a recorder-INI file in the type directory. The INI file will
then point to the data directory (the recorder’s directory). If the user has enabled the
“Browse first in the user directory” in the user path definitions, the search starts in the
user defined directory, where a *.RID file must be selected.

Recorder Related Files

Every file that is recorder related has the following name format:
Xnnnn: The name is the serial no. of the recorder

Ext Description File type
RID Recorder information data Binary
RIT Recorder information text Text
RBD Recorder backup data Binary
RDD Recorder SNMS* download information data Binary
RDT Recorder SNMS* download information text Text

*SNMS: Start New Measurement Sequence

The recorder ID (RIT) can at a later time be opened, and the related measurement
data can be viewed, printed and reconverted. The RDD, RDT and DIR are download
information files, created when a new measurement sequence is started.
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Measurement related Files
Every file that is specifically measurement related has the following name format:

mmmXnnnn: The name is the measurement number + serial no.

Ext Description File type
MID Measurement information data Binary
MIT Measurement information text Text
MDD Measurement download information data Binary
MDT Measurement download information text Text
CIT Measurement conversion information text Text
DAD Measurement Data Binary file Binary
DAB Measurement Data Binary file Text
DAT Measurement Data Binary data Text

The MID, MIT and DAD files are created upon measurement data retrieval from the
recorder. The DAB, DAT and CIT files are created when converting the data. The
MDD and MDT are download information files and created when a new measurement
seqguence is started.

Data Files
Upon data retrieval, three main data files are created.

The *.DAD File

This file is the raw data source file. The data is in mixed binary form. The user cannot
access this file in the SeaStar program. When converting these raw data into
measurements, the *.MID file is needed. The result from the conversion are two data
files, the * DAB and the *.DAT.

The *.DAB File

This file contains sequential binary representation of the data in columns. The first
column is the measurement number. The other columns contain the measured
parameters in a binary form.

The *.DAT File

This is the actual result file, where the measurements are converted to their natural
units and timed. This is a text file with columns. The first column is the measurement
number, the second column the date and the time, depending on the set-up. The third
column is the time or the first measured parameter, depending on set-up. The
following column(s) contain the converted measured parameters with units and
number of decimals according to set-up. Number of parameters can range from 1-3,
and number of columns 3-6 accordingly.

Data Header

The *DAT file contains a data header, which is a detailed description of how the
*DAT file is configured. This feature is used by SeaStar when graphically
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representing the data, and is practical if the user wants to import the data into other
applications or databases. Most of these descriptive items are derived from the
‘Settings’ menu and the recorder type definition in the ‘File’ menu.

Each header item is contained in one line, and all header lines start with a #
(bookmark) and a number. Then follows a description of the header item, and then 1-4

directives, all separated by tabs. Eventually a comment trails the directives, preceded
by a ; (semicolon).

A2 Help Menu

Choose Help and the following window appears:

") SeaStar 5.60 - DST cunti-ax - C\SwaStar\DST canti\ =N EEE )

File Edit Recorder Settings View Wizards Window

User Manual
Troubleshooting
Release Notes
Check for Updates

Submit Ticket  F1
About...

_[PowOn [Comi |

Help topics |

Figure A.1 Help Menu

User Manual
Select User Manual to open the DST magnetic user manual.

Troubleshooting
Select Troubleshooting to open the Trouble-Shooter.

Release Notes

Select Release Notes to view a description of the latest features added to SeaStar,
the date when they were added and a reference to the chapter number of each
manual where the additions can be found.
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Check for Updates

Select Check for Updates to manually update the latest version of SeaStar, User
Manual, Trouble-Shooter and Release Notes. The following window appears:

) Select files to download

[~ Application
[~ SeaStar.5.24.zip (0,00 B)

Files Selected: 0
Total Size: 0,00 B

i |

Figure A.2 Select files to download

Select the files you want to download and click OK. The program downloads and
installs the latest updates to the software. Please note that this can only be done
when the program is offline i.e. when no recorder is connected to the program.

Change Log is displayed if a new application version is available while updating (see
figure A.3)

W Select files %0 dowrdoad

™ Apphcation

[ SeaStar.5.32.20 (267ME) | hayiar Chnges
Mo hanges

Changet oG & daplayed if & new
BOPICAn0N verson & avalabie whie r
Jodatng

Apphcanon e s2e &5 now correctly
Gspayed mhen updating

Zovling wrom )

Active sanes now alows the user %o right
Kok and sedect: o, none., nvert

Low batiery warning when starting & nes
yrescurement sequence £ e battery leve
§s below 0%
Fles Selectec: 0 Wizards: If multi mede £ actve then the

jstart new mescurement settings s skpped

otal Sine: 0,008 fand £ completnd succeeshdy offers tn
yepoat he waard.
{

1 Cancel
Wawrds: Added o notficason to remnd

Figure A.3 Change Log
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By selecting Settings-Options-Update you can now choose whether you want to
update SeaStar manually, every X number of days or every time SeaStar is run.

Settings lﬂ—hj
[Update |
Check for updates

" Manually

{" Every |30 :I days

(¢ Every time SeaStar is run

Last check was 0 days ago

OK I Cancel

Figure A.4 Update

Submit ticket

Tickets can now be sent directly from the application to our support department by
selecting Help-Submit Ticket. A shortcut key, F1, can also be used at any time while
in the application and is especially useful when the menu bar is disabled.

In the ticket form (see figure A.5) you can add your name and email. Select a category
that best describes your problem and write a subject and description. If you like you
can select Images (screenshots) and browse for images in the screenshots folder
and send them with the ticket. By selecting Other files you can also add files to the
ticket. To automatically add recorder data use the Include Recorder Data option. By
default the following files are included: screenshot, system information, logs and
settings. These can be excluded with options in Other files.

To receive a response we require that you include a valid email address.
Tickets can also be created by e-mailing support@star-oddi.com with the problem
description and files attached.

If you want to add more information to a previously created ticket you can reply to the
support response.
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() Submit Ticket I-E&-l
Name I rIndude Recorder Data-

* None
Email | el

¢ Al =

Category ([fiiaieties)

Message ‘Images (screenshots) ] Other Files

Subject I

OK | Cancel

Figure A.5 Submit ticket

About
Select About for general information about SeaStar.

A3 Recorder Backup

As mentioned in chapter 10, if the constants from the MID and RID file are corrupt, the
user should contact Star-Oddi for a RBD file and transmit it to the recorder.The name
of the backup file is Txxxx.RBD (serial no. of the recorder plus the .RBD ending).

Downloading the backup file:

Copy the backup files (RBD) into the SeaStar RBD directory.

Open the SeaStar software.

Plug a recorder to the PC computer.

Select the 'File' menu and 'Recorder backup' command and the following window
appears:

PONPE
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Select a recorder *.RBD file E]
Leita i: |l’f} RED ﬂ &5 B

14 C4665. RED
4] C4795.RED
14]10119.RED
| k2336.RED
1] k2339.RED
14] k2343.RED
14] k2344,RED
14] k2345.RED

S =

14] K2348.RED
4] K2350,RBD
4] K2351.RBD
4] MB411.RED
4] MB419. RED
14 M8452 RED
14 00001.RBD
14 QO002.RED

1] Q0003 RED
14] 51523.RED
4] Y0877 .RED

Heiti hiutar: |

-]
j Hazetta wid

Figure A.6 Select a Recorder *RBD File

Hiutir af gerd: | Recarder Backup Data file[C* rbd)

Browse for the correct RBD file on the computer and click OK.
5. Insert the sequence number and remaining battery life (see figure A.7). Note that if
the sequence number is set too low, data will be overwritten.

Set Sequence Number and ... EI

Seq. number from EBD file: 0

Input new sequence number:

Set battery hfe remaining (%40) 100 T

| (1]:8 | ’ Cancel I

Figure A.7 Set Sequence Number
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6. The SeaStar software downloads the RBD file into the recorder and the window in
figure A.8 appears. Click OK.

Backup operation EI

The backup data are in the recarder 1
The recarder iz Off-line \’)

Fleaze connnect again |

Ok

Figure A.8 Backup Operation
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